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1  Introduction
Cisco Unity Connection now supports the SMTP-based HTML notifications that is an attractive 
mechanism for delivering the voice message notifications to the end users. The HTML notification 
functionality is a robust and customizable solution that provides flexibility to send an email notification 
in the HTML format via SMTP. The notified voice messages can be accessed on computer using both web 
email clients (for example, Gmail) and desktop email clients (for example, Microsoft Outlook and IBM 
Lotus Notes). On the mobile device, the messages can be accessed only through web email clients (for 
example, Gmail).



Unlike the text-based SMTP notifications, the HTML notification functionality makes listening to your voice message just a 
click away. Once the user clicks on the link given in the HTML based notification email, the Mini Web Inbox client application 
on the web browser is loaded to play that notified voice message. The HTML notification is also an alternative to traditional 
Unified Messaging and IMAP email client settings, which allows integration with not only Exchange and Domino, but with 
Gmail as well.

To configure the HTML notifications from Cisco Unity Connection Administration and Cisco Personal Communications 
Assistant in Unity Connection version 10.x, refer to the guide available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/quick_start/guide/10xcucqsghtmlnotifications.html.

The HTML notification functionality facilitates the users to receive the notifications that can include customized icons, header, 
and footer along with the link to perform different actions on voice messages using Cisco Unity Connection Mini Web Inbox. 
Unity Connection Mini Web Inbox is a browser-based client application that allows the user to play, reply, reply all, forward, 
or delete the notified voice messages over computer or mobile devices. On mobile, Unity Connection Mini Web Inbox is 
supported via telephone record and playback (TRAP) connections on all native browsers for IPhone.

For more information on the compatibility of Unity Connection Mini Web Inbox with operating systems and browsers, refer to 
Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html. 

The content and format of the HTML notifications received via email can be customized through a notification template, custom 
variables, and custom graphics. Only the administrator has the rights to create and modify the notification templates. 
Cisco Unity Connection Administration and the Cisco Unity Connection Provisioning Interface (CUPI) APIs can be used to 
manage notification templates. 

For more information on how to manage notification templates through Connection Administration, refer to the “Adding, 
Modifying, or Deleting a Notification Template in Cisco Unity Connection 10.x” chapter of the User Moves, Adds, and Changes 
Guide for Cisco Unity Connection Release 10.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmacx.html.

For more information on how to manage notification templates using CUPI APIs, refer to the “HTML Notification Templates” 
section of the Cisco Unity Connection APIs.

To use the HTML notification templates, you must enable the HTML notification device and assign a notification template. 
Connection Administration and the CUPI APIs are used to create, update, and delete an HTML notification device. The HTML 
notification devices can be managed for an individual user, or for multiple users by using the Bulk Edit utility in 
Connection Administration.

For more information on how to manage notification devices through Connection Administration, refer to the “Notification 
Devices in Cisco Unity Connection 10.x” section in the “Setting Up Features and Functionality That Are Controlled by User 
Account Settings in Cisco Unity Connection 10.x” chapter of the User Moves, Adds, and Changes Guide for Cisco Unity 
Connection Release 10.x available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmacx.html.

The Unity Connection users are also allowed to set up an HTML notification device and configure the other settings using the 
Unity Connection Messaging Assistant Web Tool of Cisco Personal Communications Assistant(PCA). The users also have a 
choice of using an outdial number to play the voice messages via the telephone record and playback functionality. This facilitates 
the users to provide their extension or mobile number that gets auto-populated in the Unity Connection Mini Web Inbox.

After an HTML notification device is enabled and a notification template is assigned, the user is then allowed to get the voice 
message notifications emails. To access the notified voice message, the user needs to click the hyperlink given in the email for 
launching the Unity Connection Mini Web Inbox. With the Unity Connection Mini Web Inbox, the user can play, reply, reply 
all, forward, or delete the voice messages using a phone or a computer. On mobile, Unity Connection Mini Web Inbox is 
supported via telephone record and playback (TRAP) connections on the native browser.

For more information on the Unity Connection Mini Web Inbox, refer to the Quick Start Guide for the Cisco Unity Connection 
Mini Web Inbox available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/quick_start/guide/b_10xcucqsgminiinbox.html. 

To troubleshoot any issues while creating templates or launching the Unity Connection Mini Web Inbox, refer to the 
“Troubleshooting the HTML Notifications in Cisco Unity Connection” chapter of the Troubleshooting Guide for Cisco Unity 
Connection available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/troubleshooting/guide/10xcuctsgx.html.
2

http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/quick_start/guide/10xcucqsghtmlnotifications.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/compatibility/matrix/cucclientmtx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmac075.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmac075.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmacx.html
o�http://docwiki-dev.cisco.com/wiki/Cisco_Unity_Connection_Provisioning_Interface_(CUPI)_API_--_HTML_Notification_Templates
http://docwiki.cisco.com/wiki/Cisco_Unity_Connection_APIs
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmac040.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmac040.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmacx.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/quick_start/guide/10xcucqsgminiinbox.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/troubleshooting/guide/10xcuctsg217.html
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/troubleshooting/guide/10xcuctsgx.html


Support of HTML Notifications Over IPv6 and IPv4
The SMTP outbound proxy is supported over IPv4 only. Therefore, Cisco Unity Connection will send HTML notifications to 
an email server over SMTP in the IPv4 only. The administrator must ensure that the HTML notifications are configured over 
IPv4. 

The users can receive the notifications and play the voice messages on supported email clients on both IPV4 and IPv6. The Unity 
Connection Mini Web Inbox URLs, which are sent in an HTML email, can be opened in either IPv6 or IPv4. To resolve 
Cisco Unity Connection in either IPv6 or IPv4, it depends upon the DNS entry configured in DNS Server. 

Note Unity Connection Mini Web Inbox over computer is supported for both, IPv4 and IPv6. However, the Unity Connection 
Mini Web Inbox over mobile supports only IPv4. For more information on how to configure IPv6, refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/upgrade/guide/10xcucrug002.html.

See the following sections: 

• Working with the Notification Template, page 3

• Working with Custom Variables, page 15

• Working with Custom Graphics

• Working with Administrative Replaceable Images

• Enabling an HTML-compatible Device to Receive HTML-Based Message Notifications

• Updating the HTML-compatible Device for Multiple User Accounts in Bulk Edit Mode

• Enabling SMTP-Compatible Notification Devices to Receive Text-Based Message Notifications 

• Using the Cisco Unity Connection 10.x Bulk Administration Tool

• Using Cisco Unity Connection Mini Web Inbox

• Using Cisco Unity Connection Imaging Interface API

• Using Cisco Unity Connection Provisioning Interface (CUPI) APIs for Administrator

• Using Cisco Unity Connection Provisioning Interface (CUPI) APIs for Users

• Managing Message Notification through the Messaging Assistant Web Tool

• Managing HTML-based Message Notifications with Email Clients

2  Working with the Notification Template
All SMTP-based HTML notifications in Cisco Unity Connection require the HTML-based notification templates. The 
administrator can define any number of customized HTML templates. The administrator can assign a template to the users or 
can allow the users to select a template. However, the users do not have the permissions to create or modify a template.

The template selected can either be a default or a custom template that the administrator has created. The default templates are 
Default_Dynamic_Icons and Default_Actionable_Links_Only. Note that you cannot edit or delete the content of the default 
templates. The Default_Dynamic_Icons template has the HTML tags along with the custom graphics and the status items. The 
Default_Actionable_Links_Only template has the HTML tags along with the actionable links without any images, custom 
graphics, or status items.

The HTML notification template provides the user an enhanced notification experience that includes the following:

• Free flow HTML text

• HTML tags, where in support of HTML tags depend on the email client that the user is using. 

• Custom Variables and Custom Graphics

• Status Items for Voice Message - MWI, Message Status as Icons within an HTML template.

• Embedded links to the external URIs/URLs
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For example, the administrators can configure the HTML templates to include header, footer, logos, images, MWI status, and 
hyperlinks to the Unity Connection Mini Web Inbox.

The examples of default templates and other customized templates are available on Sample Templates for Intelligent 
Notifications.

Note • The use of images, MWI status, and Message status is not mandatory. However, if used, the administrators need to 
ensure that the image rendering when used with the HTML tags and the APIs is supported by their respective email 
clients.

Note • Make sure the signed SSL certificates are installed in order to access the notifications via email and the voice 
message via Unity Connection Mini Web Inbox. For more information on how to configure SSL on Cisco Unity 
Connection, refer to the “Securing Cisco Unity Connection Administration, Cisco PCA, and IMAP Email Client 
Access to Cisco Unity Connection 10.x” chapter of the System Administration Guide for Cisco Unity Connection 
Release 10.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsagx.html. 

HTML Notifications Support for the IPv6 and IPv4 Modes
The SMTP outbound proxy is supported over the IPv4 mode only. Therefore, Cisco Unity Connection will send the HTML 
notifications to an email server over SMTP in the IPv4 mode only. The administrator must ensure that the HTML notifications 
are working over IPv4. 

The users can receive the notifications and play the voice messages on supported email clients for both the IPV4 and IPv6 mode. 
The Unity Connection Mini Web Inbox URLs sent over an HTML email, can be accessed through the IPv6 or IPv4 mode, 
depending upon the DNS domain entry configured in the DNS Server to resolve Cisco Unity Connection in either IPv6 or IPv4.

Note The Unity Connection Mini Web Inbox over computer is supported for both, the IPv4 and IPv6 modes. However, the 
Unity Connection Mini Web Inbox over mobile supports only the IPv4 mode. For more information on how to 
configure the IPv6 address, refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/upgrade/guide/10xcucrug051.html.

Unity Connection provides facility to search, create new, and edit the notification templates. See the following sections:

• Search Notification Templates

• New Notification Template

• Edit Notification Template

Search Notification Templates
The Search Notification Templates page displays the status with the total number of templates created by an administrator.

The administrator can search the HTML templates that are used for sending HTML notifications. The search results, by default, 
return all templates including default and custom templates. By default, the administrator can view 25 records per page and can 
select rows per page from the drop down list, the max limit being 250 search results returned on one page. The administrator 
can perform custom search on the template name field using the following options:

• Begins with

• Contains.

• Ends with

• Is Exactly

• Is Empty

• Is Not Empty
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Table 1 Search Notification Templates

Field Description

Notification Template Name The name of the notification template.

Select the Notification Template Name to go to the specific page for the 
notification template. The templates can be arranged in the ascending or 
descending order based on default or custom search.

Delete Selected To delete a notification template, check the check box to the left of the 
notification template name, and click Delete Selected. You can delete multiple 
notification templates at once.

Note that you are not allowed to delete any default templates. In addition, if a 
template is assigned to an HTML notification device, then you cannot delete 
the template unless all the existing associations with it are removed.

Add New To add a notification template, select the Add New button. The New 
Notification Template page opens and you can enter the data applicable to the 
new notification template.

Show Dependencies Before deleting a template, use the Show Dependencies button to launch a 
search for Unity Connection users and users templates that have HTML 
notification devices associated with the template. When all dependencies have 
been reassigned or removed, you can delete the template.

Note that you cannot use the show dependencies option for multiple templates 
at one time.

Go To go to a specific page, the administrator can enter the page number and click 
Go. The administrator can also use page navigation to go to first, previous, 
next, last page accordingly.
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New Notification Template

Table 2 New Notification Template

Field Description

Display Name Enter a descriptive name for the notification template.

HTML The left HTML panel lists the items and variables that can be used in an HTML template. The right 
HTML panel allows administrator to create HTML templates. The HTML template can include 
HTML tags, text along with the status items, action items, custom graphics, custom variables, or 
static items.

The left HTML panel stores a list of the following items:

• Status Items: The strings specified here give the current state of the user's mailbox in an icon 
format that includes MWI status and the Message status of a voice message. To insert the status 
items directly in the notification template, you must use the <img src="%MWI_STATUS%"> 
</img> tag or the <img src="%MESSAGE_STATUS%"> </img> tag.

• Action Items: The strings specified here are used to perform an action on a particular message, 
for example, launching the Mini Web Inbox, Web Inbox, or full inbox view and auto-playing a 
message. These action items, when used, require authentication, where credentials are saved for 
the session so that multiple actions can be performed, for example, replying or deleting a 
message. To insert the status items directly in the notification template, you must use the <a href> 
tag. For example, the <a href=”%LAUNCH_MINI_INBOX%”></a> tag.

• Static Items: The strings specified here get replaced with the corresponding content associated 
with the message, for example, caller id (sender's extension), sender’s alias, or receiver's alias.

• Custom Variables: The strings specified here list the variables that are defined by the 
administrator on the Templates > Notification Templates > Custom Variables page.

• Custom Graphics: The strings specified here list the graphics that are defined by the 
administrator on the Templates > Notification Templates > Custom Graphics page.

Note The administrator can create an HTML template for notification without status items, 
custom graphics, and images. To display any status items and custom graphics in an 
HTML template notification, make sure your email provider/server and email client 
support it. For more information on how to configure your Microsoft Outlook for 
displaying images, refer to Configuring Cisco Unity Connection 10.x for HTML-based 
Message Notification, page 43.

The right HTML panel consists of the template content. For more information on each item and 
variables, refer to Working with the Notification Template, page 3.

Validate Checks for the correctness of the entered HTML text. Unity Connection validates the HTML content 
given in the template.

Note that the validator only validates HTML content not CSS.
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Edit Notification Template

Checklist for Creating and Rendering a Template - Must Haves

Table 3

Field Description

Display Name Enter a descriptive name for the notification template.

HTML The left HTML panel lists the items and variables that can be used in an HTML template. The right 
HTML panel allows administrator to create HTML templates. The HTML template can include HTML 
tags, text along with the status items, action items, custom graphics, custom variables, or static items.

The left HTML panel stores a list of the following items:

• Status Items: The strings specified here give the current state of the user's mailbox in an icon 
format that includes MWI status and the Message status of a voice message. To insert the status 
items directly in the notification template, you must use the <img src="%MWI_STATUS%"> 
</img> tag or the <img src="%MESSAGE_STATUS%"> </img> tag.

• Action Items: The strings specified here are used to perform an action on a particular message, for 
example launching the Mini Web Inbox, Web Inbox, or full inbox view and auto-playing a 
message. These action items, when used, require authentication, where credentials are saved for 
the session so that multiple actions can be performed, for example, replying or deleting a message. 
To insert the status items directly in the notification template, you must use the <a href> tag. For 
example, the <a href=”%LAUNCH_MINI_INBOX%”></a> tag.

• Static Items: The strings specified here get replaced with the corresponding content associated 
with the message or the notification device definition, for example, caller id (sender's extension), 
sender’s alias, or receiver's alias.

• Custom Variables: The strings specified here list the variables that are defined by the administrator 
on the Templates > Notification Templates > Custom Variables page.

• Custom Graphics: The strings specified here list the graphics that are defined by the administrator 
on the Templates > Notification Templates > Custom Graphics page.

Note The administrator can create an HTML template for notification without status items, 
custom graphics, and images. To display any status items and custom graphics in an 
HTML template notification, make sure your email provider/server and email client 
support it. For more information refer to Configuring Cisco Unity Connection 10.x for 
HTML-based Message Notification, page 43.

The right HTML panel consists of the template content. For more information on each item and 
variables, refer to Working with the Notification Template, page 3.

Previous Opens the previous notification template from the list.

Next Opens the next notification template from the list.

Validate Checks for the correctness of the entered HTML text. Unity Connection validates the HTML content 
given in the template.

Note that the validator only validates HTML content not CSS.

Preview Displays preview of an HTML-based SMTP notification for selected template. The Preview option 
is available only after creating and saving a template.

Note that the Preview option displays the view as per your default browser, however, the display may 
vary on the different email client.
7



For more information on ‘Must Haves’ for Cisco Unity Connection Mini Web Inbox, refer to Using Cisco Unity Connection 
Mini Web Inbox, page 27.

See the following procedures to work with a notification template:

• Create a Notification Template

• Modify a Notification Template

• Delete a Notification Template

Create a Notification Template
The content and format of the HTML notifications received via an email can be customized through a notification templates 
that include status items, action items, static items, custom variables, and custom graphics. Only the administrator has the rights 
to create and modify the notification templates, custom variables, and custom graphics. Cisco Unity Connection Administration 
and the Cisco Unity Connection Provisioning Interface (CUPI) APIs can be used to create, update, and delete the customized 
notification templates. 

For more information on how to create a notification template, refer to Cisco Unity Connection Provisioning Interface (CUPI) 
API -- Notification Devices.

To Create a Notification Template

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Notification Templates.

Step 2 Select Add New on the Search Notification Templates page.

Table 1-4 Checklist for Creating and Rendering a Template

Configuration Steps Related Topics and Documentation

Step 1 Ensure to use valid HTML tags, text, and variables. In case of rendering the HTML templates on 
Microsoft Outlook, refer to MSDN 
documentation:

• “Word 2007 HTML and CSS Rendering 
Capabilities in Outlook 2007-Part 1” and 

• “Word 2007 HTML and CSS Rendering 
Capabilities in Outlook 2007-Part 2”.

Step 2 Ensure that a notification template is assigned to an HTML 
notification device.

Enabling an HTML-compatible Device to 
Receive HTML-Based Message Notifications, 
page 23.

Step 3 Ensure that the HTML notification device is enabled for the 
user.

Enabling an HTML-compatible Device to 
Receive HTML-Based Message Notifications, 
page 23.

Step 4 Ensure that the desired authentication mode is selected. There 
are two modes supported, Authentication and 
Non-authentication mode. 

Configuring Cisco Unity Connection 10.x for 
HTML-based Message Notification, page 43.

Step 5 Ensure that if your HTML templates include images, icons 
using custom graphics, or status items for an email 
notification, the images being rendered on an HTML email is 
supported by your email client.

The script utility for regedit and hotfixes for your Microsoft 
Outlook configuration is also available over Outlook Patches 
for Intelligent Notifications.

Configuring Cisco Unity Connection 10.x for 
HTML-based Message Notification, page 43
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Step 3 Enter a display name on the New Notification Template page.

Step 4 Enter the HTML content on the right panel. The HTML5 tags can also be added in the content of the notification 
template, however, the support of all the HTML tags depends on the email client that the user is using.

Note When the administrator creates or updates an HTML notification template, Unity Connection validates the HTML 
content given in the template.

Step 5 (Optional) Select and copy the required status, action, and/or static items from the left panel of the HTML field and 
paste the items on the right panel. The description of the items are given below:

Table 5 HTML Variables

Items Description

%MWI_STATUS% Displays the image based on MWI status. 

The default images are displayed as defined in the Administrative Replaceable 
Images section. However, the administrator can upload a new image through the 
administrative replaceable images option. For more information refer to Working 
with Administrative Replaceable Images, page 21.

To insert the status items directly in the notification template, you can use the <img 
src="%MWI_STATUS%"> </img> tag.

%MESSAGE_STATUS% Displays the message status as unread, read, unread urgent, read urgent, or deleted.

The default images are displayed as defined in the Administrative Replaceable 
Images section. However, the administrator can upload a new image through the 
administrative replaceable images option. For more information refer to Working 
with Administrative Replaceable Images, page 21.

To insert the status items directly in the notification template, you can use the <img 
src="%MESSAGE_STATUS%"> </img>tag.

%LAUNCH_MINI_INBOX% Launches the Unity Connection Mini Web Inbox. 

To insert this item directly in the notification template, you can use the <a 
href="%LAUNCH_MINI_INBOX%"> Text </a>tag.

%LAUNCH_WEB_INBOX% Launches the Cisco Unity Connection Web Inbox only on computer. 

To insert this item directly in the notification template, you can use the <a 
href="%LAUNCH_WEB_INBOX%"> Text </a>tag.

%MESSAGE_PLAY_MINI_INBOX% Launches the Unity Connection Mini Web Inbox for a specific message and auto 
plays the message. 

To insert this item directly in the notification template, you can use the <a 
href="%MESSAGE_PLAY_MINI_INBOX%"> Text </a> tag.

%MESSAGE_DELETE% Deletes the voice message. To insert this item directly in the notification template, 
you can use the <a href="%MESSAGE_DELETE%">Text </a> tag.

%MESSAGE_FORWARD% Forwards a particular voice message. To insert this item directly in the notification 
template, you can use the <a href="%MESSAGE_FORWARD%">Text </a> tag.

%MESSAGE_REPLY% Launches the Unity Connection Mini Web Inbox with the Reply to Message 
window to reply to a voice message. 

To insert this item directly in the notification template, you can use the <a 
href="%MESSAGE_REPLY%">Text </a> tag.

%MESSAGE_REPLY_ALL% Launches the Unity Connection Mini Web Inbox with the Reply to Message 
window. The To and Subject fields get populated automatically with multiple 
recipients. 

To insert this item directly in the notification template, you can use the <a 
href="%MESSAGE_REPLY_ALL%">Text </a> tag.
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The above action items are displayed as icons, images, or links in the email notification that is sent to the user. As a link is 
clicked from an email notification, it opens the Cisco Unity Connection Mini Web Inbox player and performs the specific 
action accordingly.

Step 6 Click Validate to verify the HTML content. Unity Connection validates the HTML content given in the template.

Note • The notification template does not get saved if any error is returned in the HTML validation. You must remove the 
error(s) returned by validation before saving the notification template. However, an HTML template with warnings 
can be saved successfully. 

Note • The validator only validates HTML content not CSS.

Step 7 Click Save.

You can also preview the template by clicking Preview. This option is available only when the new notification template is 
saved.

%MESSAGE_MARKUNREAD% Launches the Unity Connection Mini Web Inbox with marking the message as 
unread and increasing the unread message count. 

To insert this item directly in the notification template, you can use the <a 
href="%MESSAGE_MARKUNREAD%">Text </a> tag.

Custom Variables The administrator can store values in the form of text and numbers in custom 
variables. For example, the administrator can use custom variables for headers and 
footers.

It replaces the value of the selected custom variable by the content as specified by 
the administrator under the Templates > Notification Templates > Custom 
Variables page.

To insert a variable directly in the notification template, as specified by the 
administrator under the Templates > Notification Templates > Custom Variables 
page, you can use the %Var1%.

For more information on custom variables, refer to Working with Custom 
Variables, page 15.

Custom Graphics The administrator can use custom graphics for adding logos, images, within an 
HTML template. The images could also be used to define Image based Template 
Structure. 

For example - See Default_Dynamic_Icons.

To insert a graphic directly in the notification template as specified by the 
administrator under the Templates > Notification Templates > Custom Graphics 
page, you can use the <img src="%GRAPHIC1%"></img> tag.

For more information on custom graphics, refer to Working with Custom Graphics, 
page 18.

%CALLER_ID% Displays the alias name of the caller who has received a voice message.

%SENDER_ALIAS% Displays the alias name of the sender who has dropped a voice message.

%RECEIVER_ALIAS% Displays the alias name of the receiver who has received a voice message.

Table 5 HTML Variables

Items Description
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Note that the Preview option displays the view as per your default browser, however, the display may vary on the various 
email clients.

Notification Template Suggestions

• Table, image, div tags in HTML works well with most email solutions including - Microsoft Outlook 2007, Microsoft 
Outlook 2010, Lotus Notes, and Gmail (Web Based).

• HTML content with plain text and hyperlinks within a template works well with most email solutions including - Microsoft 
Outlook 2007, Microsoft Outlook 2010, Lotus Notes, and Gmail (Web Based).

• HTML background image tag is not supported while creating a notification template.

• Image overlaying other image is not supported while creating a template. For example, an image over a background image.

• Use of images, custom graphics, icons for status items - MWI, Message Status are not mandatory for HTML-based 
notifications. If images, custom graphics, and icons for status items are used, it is recommended for administrators to check 
the support or documentation of email clients being used.

• Use minimal CSS within an HTML template. You can use only the inline CSS that is supported in an HTML template, 
whereas the external CSS is not supported in the notification templates. In addition, the HTML editor that is used to create 
templates validates only the HTML content and not the CSS.

• There is no support for Java Script or other scripting languages with-in HTML.

• To troubleshoot any issue while creating templates or launching the Unity Connection Mini Web Inbox, refer to 
Troubleshooting the HTML Notifications in Cisco Unity Connection, page 48.

Example 1 of a Default Notification Template - Default_Actionable_Links_Only

<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>Untitled Document</title>
</head>

<body topmargin="0" leftmargin="0" marginheight="0" marginwidth="0" bgcolor="#F4F4F4">
<table width="100%" cellpadding="0" cellspacing="0" bgcolor="F4F4F4" style="font-family:Arial, Helvetica, 
sans-serif;font-size:13px;color:#828282;">
<tr>
<td>
<table align="center" width="500" cellpadding="0" cellspacing="0" border="0">
<tr>
<td style="color:#9DA8B7; font-size:11px;padding: 10px 0 10px 28px;"><br/></td>
</tr>
<tr>
<td>
<table align="center" width="500" cellpadding="0" cellspacing="0" border="0">
<tr>
<td>
<table cellspacing="0" cellpadding="10" border="0">
<tr>
<td width="500" align="left" valign="top" bgcolor="#CBDDFF">
<div style="font-size:18px; color:#3573AD;">Voice Message from %SENDER_ALIAS% </div> <br>
</td>
</tr>
<tr>
<td width="500" align="right" valign="top" bgcolor="#CBDDFF">
                                                                                        <div 
style="font-size:11px;color:#3573AD;"><a href = "%MESSAGE_PLAY_MINI_INBOX%">Play</a> <a href 
="%MESSAGE_FORWARD%"> Forward</a> | <a href ="%MESSAGE_REPLY%"> Reply</a> | <a href ="%MESSAGE_DELETE%"> 
Delete</a></div>
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</td>
</tr>
</table>
</td>
</tr>
</table>
</td>
</tr>
<tr>
<td height="1" bgcolor="#0066FF"></td>
</tr>
<tr>
<td>
<table align="center" width="500" cellspacing="0" cellpadding="0">
<tr>
<td>
<table cellspacing="0" cellpadding="10" border="0" bgcolor="#CBDDFF">
<tr>
<td align="left" style="font-size:12px; color:#65788A;text-align:justify;" width="500" valign="top">
<div style="font-size:12px; color:#65788A;">
<strong>Intelligent Notifications </strong> 
<br /> <br /> Intelligent Notifications deliver rich, customizable, and actionable voice message notifications.  
When connected to the corporate network, they provide users the ability to play, reply, forward, mark unread, 
and delete a specific message.
</div>
</td>
</tr>
</table>
</td>
</tr>
</table>
</td>
</tr>
<tr>
<td align="left" style="font-size:11px; color:#9DA8B7; padding: 15px 11px 0 11px; text-align:justify;">
<b> Disclaimer: </b>This message contains confidential information and is intended only for the individual 
named. If you are not the named addressee you should not disseminate, distribute or copy this e-mail. Please 
notify the sender immediately by e-mail. If you have received this e-mail by mistake and delete this e-mail from 
your system. If you are not the intended recipient you are notified that disclosing, copying, distributing or 
taking any action in reliance on the contents of this information is strictly prohibited. </b>
<hr size="1" color="#D4D4D4">
<p style="padding-top: 0pt; " class="paragraph_style"> <font size="1" align = "right" face = "Arial" 
color="black"> Â© 2012 Cisco Systems, Inc. <br /> <a title="http://www.cisco.com/" 
href="http://www.cisco.com/">Cisco.com</a> <span class="style">|</span> <a 
title="http://www.cisco.com/en/US/swassets/sw293/privacy_statement.html" 
href="http://www.cisco.com/en/US/swassets/sw293/privacy_statement.html">Privacy Statement</a> <span 
class="style">|</span> <a title="http://www.cisco.com/en/US/swassets/sw293/trademark_statement.html" 
href="http://www.cisco.com/en/US/swassets/sw293/trademark_statement.html">Trademarks</a><br /> </font> </p>
</td>
</tr>
</table>
</td>
</tr>
</table>
</body>
</html>

Example 2 of a Default Notification Template - Default_Dynamic_Icons

<html xmlns="http://www.w3.org/1999/xhtml">
<head>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />
<title>Untitled Document</title>
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</head>

<body topmargin="0" leftmargin="0" marginheight="0" marginwidth="0" bgcolor="#F4F4F4">
<table width="100%" cellpadding="0" cellspacing="0" bgcolor="F4F4F4" style="font-family:Arial, Helvetica, 
sans-serif;font-size:13px;color:#828282;">
<tr>
<td>
<table align="center" width="552" cellpadding="0" cellspacing="0" border="0">
<tr>
<td style="color:#9DA8B7; font-size:11px;padding: 10px 0 10px 28px;"><br/></td>
</tr>
<tr> <td><img src="%DEFAULT_TOP%" width="552" height="76px" /></td></tr>
<tr>
<td>
<table align="center" width="552" cellpadding="0" cellspacing="0" border="0">
<tr>
<td>
<table cellspacing="0" cellpadding="10" border="0">
<tr>
<td width="552" align="right" valign="top" bgcolor="#CBDDFF">
<div style="font-size:18px; color:#3573AD;">Voice Message from %SENDER_ALIAS% </div> <br>
<div style="font-size:11px;color:#3573AD;"><a href = "%MESSAGE_PLAY_MINI_INBOX%">Play</a> <a href 
="%MESSAGE_FORWARD%"> Forward</a> | <a href ="%MESSAGE_REPLY%"> Reply</a> | <a href ="%MESSAGE_DELETE%"> 
Delete</a> </div>
</td>
</tr>
</table>
</td>
</tr>
</table>
</td>
</tr>
<tr>
<td height="1" bgcolor="#0066FF"></td>
</tr>
<tr>
<td>
<table align="center" width="552" cellspacing="0" cellpadding="0">
<tr>
<td>
<table cellspacing="0" cellpadding="2" border="0" bgcolor="#CBDDFF">
<tr>
<td align="left" style="padding:13px 0 13px 0;font-size:12px; color:#65788A;" valign="top" width="170">
                                                                                        <div style="padding:0 
13px 0 13px;font-size:12px; color:#65788A;">&nbsp;&nbsp;<strong>Message Status </strong></div> <br>
<div  style="font-size:11px;color:#3573AD;padding:0 13px 0 13px; margin-left: 0.5em;">
<a href= "%MESSAGE_PLAY_MINI_INBOX%"> <img src="%MWI_STATUS%" border="0"></img></a>&nbsp;&nbsp;    
<img src="%MESSAGE_STATUS%"></img>  

</div>
</td>
<td align="left" style="padding:13px 0 13px 0;font-size:12px; color:#65788A;text-align:justify;" valign="top">
                                                                                                        
<strong>Intelligent Notifications </strong> <br /> <br /> Intelligent Notifications deliver rich, customizable, 
and actionable voice message notifications.  When connected to the corporate network, they provide users the 
ability to play, reply, forward, mark unread, and delete a specific message.  
</td>
<td width="25" height="41" valign="top"></td>
</tr>
</table>
</td>
</tr>
</table>
</td>
</tr>
<tr> <td><img src="%DEFAULT_BOTTOM%" width="552" height="76px" /></td>       </tr>
<tr>
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<td align="left" style="font-size:11px; color:#9DA8B7; padding: 15px 28px 0 28px; text-align:justify;">
<b> Disclaimer: </b>This message contains confidential information and is intended only for the individual 
named. If you are not the named addressee you should not disseminate, distribute or copy this e-mail. Please 
notify the sender immediately by e-mail. If you have received this e-mail by mistake and delete this e-mail from 
your system. If you are not the intended recipient you are notified that disclosing, copying, distributing or 
taking any action in reliance on the contents of this information is strictly prohibited.  </b>
<hr size="1" color="#D4D4D4">
<p style="padding-top: 0pt; " class="paragraph_style"> <font size="1" align = "right" face = "Arial" 
color="black">  Â© 2012 Cisco Systems, Inc. <br /> <a title="http://www.cisco.com/" 
href="http://www.cisco.com/">Cisco.com</a> <span class="style">|</span> <a 
title="http://www.cisco.com/en/US/swassets/sw293/privacy_statement.html" 
href="http://www.cisco.com/en/US/swassets/sw293/privacy_statement.html">Privacy Statement</a> <span 
class="style">|</span> <a title="http://www.cisco.com/en/US/swassets/sw293/trademark_statement.html" 
href="http://www.cisco.com/en/US/swassets/sw293/trademark_statement.html">Trademarks</a><br /> </font> </p>
</td>
</tr>
</table>
</td>
</tr>
</table>
</body>
</html>

Modify a Notification Template

To Modify a Notification Template

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Notification Templates.

Step 2 On the Search Notification Templates page, select the display name of the notification template that you want to 
modify.

Note If the notification template does not appear in the search results table, set the applicable parameters in the search 
fields at the top of the page, and select Find.

Step 3 On the Edit Notification Template <device> page, change the settings, as applicable. You can update the template by 
adding new items or your own static content.

Note For field information, in the Help menu, select This Page.

Step 4 Click Validate to verify the HTML content. Unity Connection validates the HTML4 and HTML5 content given in the 
template.

Note • The notification template does not get saved if any error is returned in the HTML validation. You must remove the 
error(s) returned by validation before saving the notification template. However, an HTML template with warnings 
can be saved successfully.

Note • The validator only validates HTML content not CSS.
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Step 5 After changing the settings on the Edit Notification Template page, select Save.

Delete a Notification Template

To Delete a Notification Template
Note that you cannot delete the system-defined default templates (Default_Dynamic_Icons and Default_Actionable_Links_Only).

In addition, if a template is assigned to an HTML notification device, then you cannot delete the template unless all the existing 
associations with the template are removed.

To Delete a Notification Template

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Notification Templates.

Step 2 On the Search Notification Templates page, check the check box next to the display name of the notification template 
that you want to delete.

Step 3 Select Delete Selected.

Step 4 Select OK.

3  Working with Custom Variables
The custom variables provide flexibility to populate content in an HTML notification. The administrators are allowed to create 
different custom variables that can be used while creating the HTML-based notification templates. For example, the custom 
variables can be used in case of defining a particular company's name, address, any numbers, or URLs. 

The administrator has rights to view, edit, and delete the existing custom variables. We recommend that you do not create more 
than 20 custom variables.

See the following sections for details of the fields:

• Search Custom Variables

• New Custom Variable

• Edit Custom Variable

Search Custom Variables
The Search Custom Variables page displays the status with the total number of variables created by an administrator.

The administrator can search for custom variables that can be used within HTML templates. The search results, by default, 
return all variables. By default, the administrator can view 25 records per page and can select rows per page from the drop down 
list, the max limit being 250 search results returned on one page. The administrator can perform custom search on the variable 
name field using the following options:

• Begins with

• Contains.

• Ends with.

• Is Exactly

• Is Empty

• Is Not Empty
15



New Custom Variable

Edit Custom Variable

Table 6 Search Custom Variables

Field Description

Display Name The name of the custom variable.

Click the custom variable name on the Search Custom Variables page to go to 
the specific page for the custom variable. The custom variables can be arranged 
in the ascending or descending order based on default or custom search.

Delete Selected To delete a custom variable, check the check box to the left of the custom 
variable name, and click Delete Selected. You can delete multiple custom 
variables simultaneously.

Note Note that Unity Connection does not prompt if a variable is used in any 
HTML-based notification template. The administrator must manually 
update the content of the notification template, wherever the deleted 
custom variables are used. If the deleted variable is not removed from 
the notification template manually then the variable will get displayed 
in the notification instead of its value.

Add New To add a custom variable, select the Add New button. The New Custom 
Variable page opens and you can enter the information applicable to the new 
variable.

Go To go to a specific page administrator can enter the page number and click Go. 
The administrator can also use page navigation to go to first, previous, next, 
last page accordingly.

Table 7 New Custom Variable

Field Description

Display Name Enter a descriptive name for the custom variable. Maximum length allowed is 
128 characters with alphanumeric and underscore only. The display name must 
be unique and should not have been used in the custom graphics or system 
defined tags.

Value Enter the value of the custom variable that can be text or numbers. The 
maximum limit of value can be 1000 characters.

Table 8 Edit Custom Variable

Field Description

Display Name A descriptive name for the custom variable. The display name is not editable.

Value Enter the value of the custom variable that can be text or numbers.

Previous Opens the previous custom variable from the list.

Next Opens the next custom variable from the list.
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See the following procedures to work with a custom variable:

• Create a Custom Variable

• Modify a Custom Variable

• Delete a Custom Variable

Create a Custom Variable

To Create a Custom Variable

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Variables.

Step 2 Select Add New on the Search Custom Variables page.

Step 3 Enter a display name on the New Custom Variables page. The maximum length allowed is 128 characters with 
alphanumeric and underscore only. 

Note The display name must be unique and should not have been used in custom graphics or system defined tags.

Step 4 Enter the value of the new custom variable in the form of the text or numbers. The max size can be 1000 characters.

Step 5 Select Save.

The new custom variables also get added in the Custom Variables list given on the Notification Template page. To insert 
these variables in the notification templates, refer to Working with the Notification Template, page 3.

Modify a Custom Variable

To Modify a Custom Variable

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Variables.

Step 2 On the Search Custom Variables page, select the display name of the custom variable that you want to modify.

Note If the custom variable that you want to modify does not appear in the search results table, set the applicable 
parameters in the search fields at the top of the page, and select Find.

Step 3 On the Edit Custom Variables page, change the settings, as applicable.

Note For field information, in the Help menu, select This Page.

Step 4 After changing the settings on the Edit Custom Variables page, select Save.

Delete a Custom Variable
Note that Unity Connection does not prompt if a variable is used in any HTML-based notification template. The administrator 
must manually update the content of the notification template wherever the deleted custom variables are used. If the deleted 
variable is not removed from the notification template then the variable will get displayed in the notification instead of its value.
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To Delete a Custom Variable

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Variables.

Step 2 On the Search Custom Variables page, check the check box next to the display name of the custom variable that you 
want to delete.

Step 3 Select Delete Selected.

Step 4 Select OK.

4  Working with Custom Graphics
The custom graphics give flexibility to populate graphic in an HTML notification. The administrators are allowed to create 
different custom graphics that can be used while creating the HTML-based notification templates. For example, the custom 
graphics can be used in case of defining a particular company's logo, or product images. 

The administrator has the rights to view, edit, and delete the existing custom graphics. We recommend that you do not create 
more than 20 custom graphics.

The graphic can either be a default or a custom graphic that the administrator has created. The default custom graphics are 
DEFAULT_BOTTOM and DEFAULT_TOP. Note that you cannot edit or delete the default custom graphics.

Ensure the following points while creating and rendering the custom graphics:

• The Authentication/Non-authentication mode is selected as desired. For more information refer to Configuring Cisco Unity 
Connection 10.x for HTML-based Message Notification, page 43.

• Note that the images or icons given using custom graphics or status items are rendered using APIs to your email client. 
Therefore, you must make sure that you have required settings/configuration done for your desktop or Web based email 
clients. For more information refer to Configuring Cisco Unity Connection 10.x for HTML-based Message Notification, 
page 43.

See the following sections for details of the fields:

• Search Custom Graphic

• New Custom Graphic

• Edit Custom Graphic

Search Custom Graphic
The Search Custom Graphics page displays the status with the total number of custom graphics created by administrator.

The administrator can search for custom graphics that can be used within HTML templates. The search results, by default, 
return all custom graphics. By default, the administrator can view 25 records per page and can select rows per page from the 
drop down list, the max limit being 250 search results returned on one page. The administrator can perform custom search on 
the custom graphic name field using the following options:

• Begins with

• Contains.

• Ends with

• Is Exactly

• Is Empty

• Is Not Empty
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New Custom Graphic

Edit Custom Graphic

Table 1-9 Search Custom Graphics Page

Field Description

Display Name The name of the custom graphic.

Click the custom graphic name on the Search Custom Graphics page to go to the specific page for 
the custom graphic. The custom graphics can be arranged in the ascending or descending order based 
on default or custom search.

Custom Graphics 
File Name

The actual file name of the custom graphic.

Preview The preview of the custom graphic. Click the image preview to view the full custom graphic.

Delete Selected To delete a custom graphic, check the check box to the left of the custom graphic name, and click 
Delete Selected. You can delete multiple custom graphics simultaneously.

Note that Unity Connection does not prompt if a graphic is used in any HTML-based notification 
template. The administrator must manually update the content of the notification template, wherever 
the deleted custom graphics are used. If the deleted graphic is not removed from the notification 
template then the variable name will get displayed in the notification instead of its value.

Add New To add a custom graphic, select the Add New button. The New Custom Graphic page opens and you 
can enter information applicable to the new graphic.

Go To go to a specific page administrator can enter the page number and click Go. The administrator 
can also use page navigation to go to first, previous, next, last page accordingly.

Field Description

Display Name Enter a descriptive name for the custom graphic. Maximum length allowed is 
128 characters with alphanumeric and underscore only. The display name must 
be unique and should not have been used in the custom variables or system 
defined tags.

Note The file must not be more than 1 MB in size and must be unique. 
You cannot upload the same graphic again. In addition, you can 
upload only the image formats and any other formats are not 
supported for uploading.

Select Image File Browse the location from where you need to upload the custom graphic and 
select the graphic.

Feild Description

Display Name A descriptive name for the custom graphic. The display name is not editable.

Select Image File Browse the location from where you need to upload the custom graphic and select 
the graphic. The size of graphic cannot be more than 1 MB.

Previous Opens the previous custom graphic from the list.

Next Opens the next custom graphic from the list.
19



See the following procedures to work with a custom graphic:

• Create a Custom Graphic

• Modify a Custom Graphic

• Delete a Custom Graphic

Create a Custom Graphic

To Create a Custom Graphic

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Graphics.

Step 2 Select Add New on the Search Custom Graphics page.

Step 3 Enter a display name on the New Custom Graphics page.

Note The display name must be unique and should not have been used in custom variables or system defined tags.

Step 4 In the Select Image File field, browse the location from where you need to upload the custom graphic and select the 
graphic.

Note The file must not be more than 1 MB in size and must be unique. You cannot upload the same graphic again. In 
addition, you can upload only the image formats and any other format is not supported for uploading.

Step 5 Select Save.

The new custom graphics also get added in the custom graphics list given on the Notification Template page. To insert these 
graphics in the notification templates, refer to Working with the Notification Template, page 3.

Modify a Custom Graphic

To Modify a Custom Graphic

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Graphics.

Step 2 On the Search Custom Graphics page, select the display name of the custom graphic that you want to modify.

Note If the custom graphic that you want to modify does not appear in the search results table, set the applicable 
parameters in the search fields at the top of the page, and select Find.

Step 3 On the Edit Custom Graphics page, change the settings, as applicable. For field information, in the Help menu, select 
This Page.

Note You are not allowed to edit the Display Name field.

The file must not be more than 1 MB in size and must be unique. You cannot upload the same graphic again. In addition, 
you can upload only the image formats and any other format is not supported for uploading.

Step 4 After changing the settings on the Edit Custom Graphics page, select Save.
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Delete a Custom Graphic
You cannot delete the system-defined default templates (DEFAULT_BOTTOM and DEFAULT_TOP).

Note that Unity Connection does not prompt if a graphic is used in any HTML-based notification template. The administrator must 
manually update the content of the notification template, wherever the deleted custom graphics are used. If the deleted graphic is 
not removed from the notification template then the display name will get displayed in the notification instead of the graphic.

To Delete a Custom Graphic

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Custom Graphics.

Step 2 On the Search Custom Graphics page, check the check box next to the display name of the custom variable that you 
want to delete.

Step 3 Select Delete Selected.

Step 4 Select OK.

5  Working with Administrative Replaceable Images
The administrator has rights to replace the default images for the following status items:

• Deleted_message

• MWI_OFF

• MWI_ON

• Read_message

• Read_urgent_message

• Unread_message

• Unread_urgent_message

These images can anytime reset to default through the Restore option given on the Search Replaceable Images page. The addition 
or deletion of any image is not allowed in the given default list.

Note The administrator can create an HTML template for notification without status items, custom graphics, and 
images. To display any status items and custom graphics in an HTML template notification make sure your email 
provider/server and email client support it. For more information refer to Configuring Cisco Unity Connection 10.x 
for HTML-based Message Notification, page 43.

See the following sections for details of the fields:

• Search Replaceable Images

• Edit Replaceable Images

Search Replaceable Images
The Search Replaceable Images page displays the status with the total number of replaceable images created by an administrator.

The administrator can search the replaceable images that are used within the HTML notifications. The search results, by default, 
return all images. The administrator can perform custom search on the replaceable images display name field using the following 
options:

• Begins with

• Contains.
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• Ends with

• Is Exactly

• Is Empty

• Is Not Empty

Note The administrative replaceable images are used by the status items given in the HTML notification template to display 
the MWI and message status. These images cannot be added directly into an HTML notification template.

Edit Replaceable Images

See the following procedures to work with a custom graphic:

• Modify a Replaceable Image

Modify a Replaceable Image

To Modify a Replaceable Image

Step 1 In Cisco Unity Connection Administration, select Templates > Notification Templates > Administrative Replaceable 
Image.

Step 2 On the Search Replaceable Image page, select the display name of the image that you want to modify.

Step 3 On the Edit Replaceable Image page, change the settings, as applicable. For field information, in the Help menu, select 
This Page.

Note You are not allowed to edit the Display Name field.

Field Description

Display Name The display name of the image.

Click the image name on the Search Replaceable Images page to go to the 
specific page of the image. The replaceable images can be arranged in the 
ascending or descending order based on default or custom search.

Image Name The image name is the name of the actual image.

Preview The preview of the image. Click the preview to view the full image.

Size The size of the image with respect to its width and height.

Restore Restores the default administrative images.

Field Description

Display Name A descriptive name for the image. The display name is not editable.

Image Source Browse the location from where you need to upload the image and select the 
image.

Previous Opens the previous image from the list.

Next Opens the next image from the list.
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After changing the settings on the Edit Replaceable Image page, select Save.

Note These replaceable images are used in the notification templates for the status items tags, for example, 
%MWI_STATUS% and %MESSAGE_STATUS% displays the MWI status and message status of the voice message.

6  Enabling an HTML-compatible Device to Receive HTML-Based Message 
Notifications
By using SMTP, Cisco Unity Connection can send an HTML or text notification to notify users that they have received a new 
message. The HTML notifications use SMTP to notify users that they have received a new voice message via email. The HTML 
notifications are used only for voice messages. In case of text notifications, the users also get notified for the calendar events. In 
addition, the text notifications can be sent to any device that supports SMTP, for example, email addresses, mobile phones, and 
text pagers. 

To enable Unity Connection to send notifications by using SMTP, the Unity Connection server must be configured to relay 
messages through a smart host. If Unity Connection is configured to deliver the HTML or text notifications but has not been 
configured to relay messages to a smart host, the notification attempt fails and the notification is put in the Unity Connection SMTP 
Server badmail folder.

When a Unity Connection user receives a new message, Unity Connection can send an HTML or text notification to an email 
address.

Note If your site includes a Unity Connection cluster, make sure that the SMTP Domain Address resolves to IP addresses of 
both the publisher and subscriber servers in order for message traffic to reach the cluster subscriber server in the event 
that the publisher or subscriber server is down. To configure the SMTP domain go to the System Settings > SMTP 
Configuration > Server page.

To enable the SMTP Smart Host for the HTML notifications, the administrator need to perform the following tasks:

Step 1 Configure the SMTP smart host to accept messages from the Unity Connection server. See the documentation for the 
SMTP server application that you are using.

Step 2 Configure the Unity Connection server by performing the following steps:

a. In Cisco Unity Connection Administration, expand System Settings, expand SMTP Configuration, then select Smart 
Host.

b. On the Smart Host page, in the Smart Host field, enter the IP address or fully qualified domain name of the SMTP 
smarthost server. Make sure to enter the fully qualified domain name of the server only if DNS is configured.

c. Select Save.

Step 3 Configure Unity Connection users or templates

Alternatively, users can set up their own HTML or SMTP-compatible devices by using the Unity Connection Messaging 
Assistant. See Managing Message Notification through the Messaging Assistant Web Tool, page 41.

When a Unity Connection user receives a new voice message the user is notified using the HTML-based notification. The HTML 
notification is triggered based on the HTML notification device settings and is received on the configured email address using 
SMTP. 

The HTML notifications augments the display of template within an email. The message notification settings for each user 
account allow you to control how and when Unity Connection notifies a user about new voice messages. When a message that 
matches the criteria set in the HTML notification device settings arrives, the Unity Connection Messaging System sends a 
notification to the user.
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Note If the SMTP smart host settings within the Unity Connection server have not been configured, Unity Connection places 
HTML notification messages in the Unity Connection SMTP server badmail folder.

By default, users and user templates include a single HTML notification device. You can modify the default HTML device, 
including enabling or disabling it, but you cannot delete it. You can also add, modify, or delete additional HTML notification 
devices.

The following table lists the fields and their description that the administrator need to set on the Notification Devices page:

Do the procedures in this section to configure the HTML notification devices for user accounts, or for an user template (which 
can be applied to users). You must set up an HTML notification device to receive notifications individually for a user. After 
setting up the default HTML notification device, you ca also use bulk edit to enable or disable this device or to change some 
settings on this device for multiple users. Along with Cisco Unity Connection Administration, the CUPI APIs can also be used 
to create, update, and delete an HTML notification device. 

For more information on using CUPI API for updating HTML notification devices, refer to the “Notification Devices” section 
of DocWiki.

To Enable an HTML-Compatible Device to Receive Message Notifications for an Individual User or 
Template

Step 1 In Cisco Unity Connection Administration, find the user account or user template that you want to edit.

Step 2 On the Edit menu, select Notification Devices.

Step 3 On the Notification Devices page, in the Display Name list, select HTML

Step 4 On the Edit Notification Device (HTML) page, check the Enabled check box.

Field Description

Display Name Enter a descriptive name for the notification device

To (Applicable only to HTML notification devices) Enter the email address of the 
user.

You can add multiple email addresses that are separated by a comma.

Select HTML Template (Applicable only to HTML notification devices) Select a default or a customized 
template.

Outdial Number (Applicable only to HTML notification devices) Enter the phone number that 
the user will use to check the voice messages using the telephone record and 
playback functionality. The number entered here must be E.164 compliant. For 
more information on the restriction rules, see the “Managing Restriction Tables 
in Cisco Unity Connection 10.x” chapter of the System Administration Guide 
for Cisco Unity Connection. 

Disable Outdial Number From Cisco 
PCA

(Applicable only to HTML notification devices) Check this checkbox to 
disallow the users to change the outdial number from the Cisco Personal 
Communications Assistant (PCA) and the Unity Connection Mini Web Inbox.

Disable HTML Template selection from 
Cisco PCA

(Applicable only to HTML notification devices) Check this checkbox to 
disallow the users to change the HTML template assignment from the Cisco 
Personal Communications Assistant (PCA). In this case, the administrator can 
assign a template for a user, thereby, restricting user to change the template from 
Cisco PCA.

Allow Voicemail as Attachments (Applicable only to HTML notification devices) Enables users to send voice 
message as an attachment with HTML notifications.
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Note The HTML notification device can be enabled or disabled by the administrator and the user. The user has the 
flexibility to override the settings through Cisco PCA.

Step 5 In the Display Name field, enter the name for a notification device.

Step 6 In the Notify Me Of field under the Event Type section, check the Urgent Only check box to enable Unity Connection 
to send the notification only when the new voice message of that type is marked urgent. 

The All Voice Messages read-only option given under the Notify Me Of field under the Event Type section is selected by default 
as the HTML notifications are applicable only for voice messages.

Step 7 In the To field under the HTML Template Mail Format section, enter a valid email address.

Note You can add multiple email addresses that are separated by a comma.

Step 8 In the Select HTML Template drop down list, select a default or customized template.

Step 9 In the Outdial Number field, enter the phone number that the user will use to check the voice messages using telephone 
record and playback functionality. The number entered here must be E.164 compliant. For more information on the 
restriction rules refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsag110.html.

Step 10 Check the Disable Outdial Number Change from Cisco PCA option to disallow the users to change the outdial number 
from Cisco PCA and Unity Connection Mini Web Inbox.

Step 11 Check the Disable HTML Template selection from Cisco PCA option to disallow the users to change the HTML 
template from Cisco PCA. In this case, the administrator can assign a template for a user , thereby, restricting user to 
change the template from Cisco PCA.

Step 12 Check the Allow Voicemails as Attachments option to enable users to send voice message as an attachment with HTML 
notifications.

Step 13 Select Save.

Step 14 Optionally, to configure additional settings for the device for an individual user, use the Related Links field to navigate 
to Edit Notification Device Details. The Unity Connection Messaging Assistant opens in another browser window, 
allowing you to change the notification schedule or limit the notification to messages sent by specific callers or phone 
numbers. The user can also change these settings by signing in to the Messaging Assistant.

Note The Related Links field appears in the upper right corner of the Administration window. Select the applicable link 
name, and then select Go.

7  Updating the HTML-compatible Device for Multiple User Accounts in 
Bulk Edit Mode
You can use the Bulk Edit feature of Unity Connection to enable or disable a device and/or to change the notification settings 
for multiple users.

Step 1 In Cisco Unity Connection Administration, on the Search Users page, check the applicable user check boxes, and select 
Bulk Edit.

If the user accounts that you want to edit in bulk do not all appear on one Search page, check all applicable check boxes on the 
first page, then go to the next page and check all applicable check boxes, and so on, until you have selected all applicable users. 
Then select Bulk Edit.

Step 2 On the Edit User Basics page, select Edit > Notification Devices.
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Step 3 On the Edit Notification Device page, check the left-most check box to select the Enabled field, and then check the 
Enabled check box.

Step 4 Under Notify Me Of, check the check box to select the Event Type field.

Step 5 In the Notify Me Of field under the Event Type section, check the Urgent Only check box to enable Unity Connection 
to send the notification only when the new voice message of that type is marked urgent.

Step 6 In the Select HTML Template drop down list, select a default or customized template.

Step 7 Check the Disable Outdial Number Change from Cisco PCA option to disallow the users to change the outdial number 
from Cisco PCA and Unity Connection Mini Web Inbox. 

Step 8 Check the Disable HTML Template selection from Cisco PCA option to disallow the users to change the HTML 
template from Cisco PCA.

Step 9 Check the Allow Voicemails as Attachments option to enable users to send voice message as an attachment with HTML 
notifications.

Step 10 Select Save.

Step 11 Enter other settings, as applicable.

Step 12 If applicable, set the Bulk Edit Task Scheduling fields to schedule the bulk edit operation for a later date and/or time.

Step 13 Select Submit.

The administrator can also bulk edit by selecting the Bulk Edit By CSV option given under the Related Links drop down list 
given on the upper right hand corner. For more information refer to Using the Cisco Unity Connection 10.x Bulk Administration 
Tool, page 26.

8  Using the Cisco Unity Connection 10.x Bulk Administration Tool

The Cisco Unity Connection Bulk Administration Tool (BAT) allows you to create, update, and delete multiple user accounts, 
contacts, distribution lists, distribution list members, or unified messaging accounts by importing information contained in a 
comma separated value (CSV) file. In addition, it allows you to export information about users, contacts, distribution lists, or 
unified messaging accounts from Cisco Unity Connection to a CSV file. When Unity Connection is running as part of Cisco 
Unified Communications Manager Business Edition (CMBE), you cannot create, update, or delete users with BAT. 
Modifications to users must be done in Cisco Unified Communications Manager Administration. 

CSV is a common text file format for moving data from one data store to another. For example, importing from a CSV file can 
be useful for transferring information from a corporate directory to Cisco Unity Connection. Transferring the information 
allows the users with voice mailboxes to add corporate directory users who are not Unity Connection users to their address 
books and to then create call-routing rules based on calls from such contacts. 

BAT supports only UTF-8 and UTF-16 character set encoding for the text in the CSV file. To quickly construct an input CSV 
file, you can use BAT to export the applicable type of user, contact, system distribution list, system distribution list members, 
or unified messaging accounts, and use the resulting output CSV file as a template.

To use BAT for adding HTML notification devices for users you need to include the following fields in input CSV files:

Column Heading Creating Updating Deleting Description

DisplayName_HTML Optional Optional N/A A descriptive name for the notification 
device. This field is required if you want to 
create an HTML notification device.

Active_HTML Optional Optional N/A Enables the HTML notification device.

callback_HTML Optional Optional N/A The phone number that user will use to play 
and record voice messages.
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9  Using Cisco Unity Connection Mini Web Inbox

About the Cisco Unity Connection Mini Web Inbox
Cisco Unity Connection allows you to deliver SMTP-based HTML notifications for a new voice message to the end users. These 
notifications can be sent via SMTP as an HTML format embedded in the email. The administrator can assign a template to the 
users or allow users to select a template. The users get the flexibility to receive the HTML notifications that can include 
customized icons, header, and footer along with the link to access Cisco Unity Connection Mini Web Inbox. 

The users can get the notifications based on the following notification template types:

• Template with the HTML text and links to Unity Connection Mini Web Inbox

• Template with customized icons, message status - MWI, Message State

• Templates can include text/images for header, footer, logo etc

Unity Connection Mini Web Inbox is a player that allows user to play the voice messages over computer or mobile 
devices/tablets. With Unity Connection Mini Web Inbox, user can play, reply, reply all, forward, or delete the voice messages 
using a phone or a computer. To access the Unity Connection Mini Web Inbox, you must click the links as displayed in the email 
notification. 

Preferably, the Unity Connection Mini Web Inbox must always be opened from a notification email as it takes certain URL 
parameters.

The HTML notifications on the computer and mobile support both non plug-in based Web email clients and desktop email 
clients, like Microsoft Outlook and IBM Lotus Notes.

On mobile, Unity Connection Mini Web Inbox is supported via telephone record and playback (TRAP) connections on all native 
browsers for IPhone. It is recommended to access the HTML notifications and launch Unity Connection Mini Web Inbox only 
through the native browsers of mobile devices. Any email clients or other Web browsers are not recommended for use.

Note To access the Unity Connection Mini Web Inbox, you must be on the corporate network or connected via Virtual 
Private Network (VPN) to the corporate network. The email notification content including the MWI status, message 
status, and custom graphics, will be visible through the authentication and/or non-authentication mode when the user 
is on the corporate network or connected to it using the VPN.

Cisco Unity Connection Mini Web Inbox Support for the IPv6 and IPv4 Modes

disableMobPCA_HTML Optional Optional N/A Disallow users to change the mobile number 
from Cisco PCA and Unity Connection 
Mini Web Inbox.

disableTemplatePCA_H
TML

Optional Optional N/A Disallow users to change the notification 
template from Cisco PCA.

SmtpAddress_HTML Optional Optional N/A The email address of the user 
text-compatible mobile phone, or another 
email account (such as a home email 
address). Up to 128 characters can be 
entered in this field.

SmtpAddress_HTML column is mandatory 
if Active_HTML column is set to 1.

templateName_HTML Optional Optional N/A A default or a customized template name.

Column Heading Creating Updating Deleting Description
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The SMTP outbound proxy is supported over IPv4 mode only. Therefore, Cisco Unity Connection will send HTML notifications 
to an Email server over SMTP in IPv4 mode only.  The administrator must ensure that the HTML notifications are working over 
IPv4. 

The administrator and the users can receive the notifications and play the voice messages on supported email clients on both 
the IPV4 mode and the IPv6 mode. The Unity Connection Mini Web Inbox URLs sent over as HTML email, can be opened in 
either the IPv6 mode or the IPv4 mode depending upon the DNS entry configured in DNS Server to resolve Cisco Unity 
Connection in either IPv6 and IPv4.

Note Unity Connection Mini Web Inbox over computer is supported for both, IPv4 and IPv6 mode. However, Unity 
Connection Mini Web Inbox over mobile supports only IPv4 mode. For more information on how to configure the IPv6 
address, refer to http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/upgrade/guide/10xcucrug051.html. 

The following screen capture displays the Unity Connection Mini Web Inbox on computer:

Note If you are using local computer to play secure messages or have selected the Private option for the Require Secure 
Messaging field on the Class of Service page of the Cisco Unity Connection Administration, you will get a warning 
message as "You must play such voice message using the phone playback and record functionality".

The following screen capture displays the Unity Connection Mini Web Inbox on mobile:

Note If you change the mobile view from portrait to landscape, you must restore the Unity Connection Mini Web Inbox 
window by double-tapping on it in order to get the full view of the Unity Connection Mini Web Inbox.

Must Haves for Unity Connection Mini Web Inbox
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Table 1-10 Must Haves for Unity Connection Mini Web Inbox

Compatibility Information For Unity Connection Mini Web Inbox With Cisco Unity 
Connection 10.0
For more information on operating system and browser support for Unity Connection Mini Web Inbox, refer to the 
Compatibility Matrix: Cisco Unity Connection and the Software on User Workstations.

Consider the following browser compatibility points while working with Cisco Unity Connection Mini Web Inbox:

Configuration Steps Related Topics and Documentation

Step 1 Ensure that you have read Compatibility Matrix for Unity 
Connection Mini Web Inbox and have required browser and 
platform.

 Compatibility Matrix: Cisco Unity 
Connection and the Software on User 
Workstations.

Step 2 Make sure the signed SSL certificates are installed to access the 
voice message via Unity Connection Mini Web Inbox.

For more information on how to configure 
SSL on Cisco Unity Connection, refer to the 
“Securing Cisco Unity Connection 
Administration, Cisco PCA, and IMAP Email 
Client Access to Cisco Unity Connection 
10.x” chapter of the System Administration 
Guide for Cisco Unity Connection Release 
10.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_
comm/connection/10x/administration/guide/
10xcucsagx.html.

Step 3 If you are using Microsoft Internet Explorer 8, confirm that you 
have configured your browser as per the settings.

Configuring Cisco Unity Connection 10.x 
for Cisco Unity Connection Mini Web 
Inbox, page 47.

Step 4 If you are using IBM Lotus Notes, confirm that you have 
configured your browser as per the settings.

Configuring Cisco Unity Connection 10.x 
for Cisco Unity Connection Mini Web 
Inbox, page 47.

Step 5 You must perform the following steps in Microsoft Internet 
Explorer to get the view of updated Unity Connection 
Mini Web Inbox:

Step 5

1. Open Microsoft Internet Explorer and then go to Tools.

2. In the Internet Options under the Browsing History section, 
click Settings.

3. In the Temporary Internet Files and History Settings window, 
select the Every time I visit the webpage option given under the 
Check the newer version of stored pages section.

4. Click Ok.

Step 6 If you are clicking Start Recording in the Unity Connection 
Mini Web Inbox for the first time while replying or forwarding 
a message, the Adobe Flash Player Settings window gets 
displayed. Perform the following steps:

• Select Allow in the Adobe Flash Player Settings window for 
privacy settings

• Select Remember in the Adobe Flash Player Settings window 
to remember these privacy settings and not getting the prompt 
for the Adobe Flash Player settings again.

• Click Close to close the Adobe Flash Player Settings window.
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• Audio Playback on Computer

– Mozilla Firefox 10 plays voice messages on Cisco Unity Connection Mini Web Inbox using HTML 5 Audio (.wav 
format).

– Microsoft Internet Explorer 8, 9 and Mozilla Firefox 3.6 require the compatible Quick Time Plug-in to play the voice 
messages.

• Audio Recording on Computer

– Microsoft Internet Explorer 8, Internet Explorer 9, Mozilla Firefox 3.6, and Mozilla Firefox 10 require the compatible 
Adobe Flash Player.

The below mentioned mobile matrix lists the mobiles and the supported browsers on these mobiles for the entire HTML 
notifications functionality:

Mini Web Inbox Controls on Computer
The following screen capture displays the Unity Connection Mini Web Inbox on mobile:

Mobile Name Supported Browsers

IPhone 3s with IOS version 4.3 and above All native browsers and third party email client are not supported.

IPhone 4 and above with IOS version 5.x All native browsers and third party email client are not supported.

1 Displays the account with which you are signed in.

2 Sign out of Unity Connection Mini Web Inbox.

3 Opens the message in Unity Connection Web Inbox.

4 View Unity Connection Mini Web Inbox Information.

5 Denotes that the message has been marked as private.

6 Denotes that the message has been marked as secure.

7 Uses the computer microphone and speakers or other default audio device to play audio.

8 Unity Connection calls you at the extension you enter in the text box to make a recording 
or to play audio. You can speak and listen through the phone handset or speakerphone.

9 Displays the unread message count.

10 Denotes the next and previous functionality.

11 Change the audio playback volume.

12 Displays the account name of the sender.

13 Click this play button to start playing a message.

14 Denotes that the message has been marked as urgent.
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Mini Web Inbox Controls on Mobile
The following screen capture displays the Unity Connection Mini Web Inbox on mobile:

Next and Previous Option
The next and previous functionality is used to traverse through only existing voice messages available in the inbox. The voice 
message is not auto-played when the user is traversing using the next and previous functionality. This functionality can be used 
on both, computer and mobile. When the user reaches at the start or end of the list, Unity Connection will give the warning 
message stating that there are no messages.

If the user deletes the message, the navigation through the next and previous messages available in the inbox can still be done 
using the Unity Connection Mini Web Inbox. The Unity Connection Mini Web Inbox window gets update with the Undelete 
option. Once the user moves to next or previous message, the deleted message will be removed from the list. Note that if a user 
manually refreshes the browser or reopens the notification link from the email, the next and previous functionality will not be 
available for the user.

1 Displays the account with which you are signed in.

2 Sign out of Unity Connection Mini Web Inbox.

3 View Unity Connection Mini Web Inbox Information.

4 Denotes that the message has been marked as private.

5 Denotes that the message has been marked as secure.

6 Unity Connection calls you at the extension you enter in the text box to make a recording 
or to play audio. You speak and listen through the phone handset or speakerphone.

7 Displays the unread message count.

8 Denotes the next and previous functionality.

9 Change the audio playback volume.

10 Click to delete the message.

11 Click to mark the particular message as unread.

12 Click to send reply to all the recipients.

13 Click to send reply to the sender.

14 Displays the account name of the sender.

15 Click this play button to start playing a message.

16 Denotes that the message has been marked as urgent.
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Play Option
The user accesses the notified voice message by clicking the hyperlinks those are given in the email notification for launching 
the Unity Connection Mini Web Inbox. The Unity Connection Mini Web Inbox auto plays the notified voice message when the 
mini player is launched from the message notification. When the user plays a message, the attached forwarded messages also 
get played in a chain. The unread message count in the Unity Connection Mini Web Inbox gets auto-refreshed after playing a 
voice message.

When the voice message is getting played, all the other message action buttons, including Reply, Reply all, Delete, Mark Unread, 
are disabled. The user can only pause or stop the voice message while listening to it.

Reply Option
User can reply to a voice message by following any of the actions given below:

• Clicking the Reply link as displayed in the email notification,

• Replying through the Computer button if accessing the Unity Connection Mini Web Inbox via computer, or

• Replying through the Phone button given in the Unity Connection Mini Web Inbox via computer or mobile

Note that when an outside caller leaves a voice message, the user will not get the Reply option.

Reply Window on Computer

Reply Window on Mobile

The user can reply to a voice message by recording through the Computer option or using the phone recording and playback 
functionality, depending upon the option selected at the time of playing a message. If a user wants to toggle between the 
Computer or Phone options on computer while replying to a message, the user needs to go back to the main Unity Connection 
Mini Web Inbox window and re-select the Computer or Phone option. The toggling between the Computer or Phone options is 
not allowed from the Reply window. In addition, the toggling is supported when the voice message is not in the playing state 
either from computer or mobile.

Note The IPhone supports recording duration for 3 minutes and 50 seconds.

Auto-Inherit Properties
The replied message auto inherits the urgent, secured, and private properties of the original message. If the original message was 
private, secure, or private and secure, the replied message will also be of the same type. The user is not allowed to edit or provide 
the private and secured properties from Unity Connection Mini Web Inbox.
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Note The recording on MAC OS is supported via telephone record and playback functionality only. The computer based 
recording is not supported.

To Reply to a Voice Message using the Computer Recording 

Unity Connection Mini Web Inbox on computer supports the Computer option to play and reply that uses the computer 
microphone and speakers or other default audio device. If you are accessing the Unity Connection Mini Web Inbox on mobile, 
the Computer option will not be available as the mobile based mini player supports only telephone record and playback 
functionality.

Step 1 Click the Reply link given in the email notification or click the Reply button given in the Unity Connection Mini Web 
Inbox. The Reply to Message window opens. 

The To and Sub fields along with the message properties gets inherited from the parent voice message. The user does not 
have an option to append or edit these fields.

Note In order to utilize the Add CC and/or Add BCC options, a user must use the Cisco Unity Connection Web Inbox 
as these options are not available from the Unity Connection Mini Web Inbox.

Step 2 Click Start Recording. 

Step 3 Record the voice message and when done, click Stop Recording. The duration of recording is displayed on the window.

Note You can even play your recorded message and if required, can re-record the message but the previously recorded 
message gets overwritten.

Step 4 Click Send to send the message. The voice message is sent to recipient with an 'RE:' added to original subject of the 
message.

To Reply to a Voice Message Using the Telephone Recording and Playback Feature 

You can reply to a voice message using the Phone option that is available on computer, as well as mobile.

Step 1 Click the Reply link given in the email notification or click the Reply button given in the Unity Connection Mini Web 
Inbox. The Reply to Message window opens.

The To and Sub fields along with the message properties gets inherited from the parent voice message. The user does not 
have an option to append or edit these fields.

Note In order to utilize the Add CC and/or Add BCC options, a user must use the Cisco Unity Connection Web Inbox 
as these options are not available from the Unity Connection Mini Web Inbox.

Step 2 Click Phone to enter an editable number or use the auto-populated number depending on the settings done for each 
user for HTML notification outdial number. The phone number entered  here can also be in  the E.164 format. In 
addition, check if there are any restriction rules are set by the administrator to block some number. For more 
information on the restriction rules refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsag110.html.
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Note A user can edit the phone number or extension, if the administrator has given rights to edit the mobile number from 
Cisco PCA. For more information to update the settings refer to Managing Message Notification through the 
Messaging Assistant Web Tool, page 41.

Note If there is no phone number configured by an administrator and even the user does not have rights to edit the mobile 
number from Cisco PCA, then the "Callback number has not been assigned. Please contact administrator" message 
is displayed.

Step 3 Click Start Recording. 

Step 4 Record the voice message and when done, click Stop Recording. The duration of the recording is displayed on the 
window.

Note You can even play your recorded message and if require, can even re-record the message. The previously recorded 
message gets overwritten.

Step 5 Click Send to send the message. The voice message is sent to recipient with an 'RE:' added to original subject of the 
message.

Reply All Option
Unity Connection Mini Web Inbox allows users to reply all to a voice message by following any of the actions given below:

• Clicking the Reply all link as displayed in the email notification or 

• Replying through the Computer button if accessing the Unity Connection Mini Web Inbox through computer, or

• Replying all through the Phone button given in the Unity Connection Mini Web Inbox via computer or mobile

Reply All Screen on Computer

Reply All Screen on Mobile

The user can reply all to a voice message by recording through the Computer option or using the phone recording and playback 
functionality, depending upon the option selected at the time of playing a message. If a user wants to toggle between the 
Computer or Phone options on computer while replying to a message, the user needs to go back to the main Reply All Screen 
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on Mobile window and re-select the Computer or Phone option. The toggling between the Computer or Phone options is not 
allowed from the Reply window. In addition, the toggling is supported when the voice message is not in the playing state either 
from computer or mobile.

Note The IPhone supports recording duration for 3 minutes and 50 seconds.

Auto-Inherit Properties
The replied message auto inherits the urgent, secured, and private properties of the original message. If the original message was 
private, secure, or private and secure, the replied message will also be of the same type. The user is not allowed to edit or provide 
the private and secured properties from the Unity Connection Mini Web Inbox.

Note The recording on MAC OS is supported via telephone record and playback functionality only. The computer based 
recording is not supported.

To Reply to a Voice Message using the Computer Recording 

Unity Connection Mini Web Inbox on computer supports the Computer option to reply all the recipients of the voice message 
that uses the computer microphone and speakers or other default audio device. If you are accessing the Unity Connection 
Mini Web Inbox on mobile, the Computer option will not be available as the mobile based mini player supports only telephone 
record and playback functionality.

Step 1 Click the Reply all link given in the email notification or click the Reply All button given in the Unity Connection 
Mini Web Inbox. The Reply to Message window opens. 

The To and Sub fields along with the message properties gets inherited from the parent voice message. The user does not 
have an option to append or edit these fields. The CC and BCC fields do not get inherited from the actual message.

Note In order to utilize the Add CC and/or Add BCC options, a user must use the Cisco Unity Connection Web Inbox 
as these options are not available from the Unity Connection Mini Web Inbox.

Step 2 Click Start Recording. 

Step 3 Record the voice message and when done, click Stop Recording. The duration of recording is displayed on the window.

Note You can even play your recorded message and if required, can re-record the message but the previously recorded 
message gets overwritten.

Step 4 Click Send to send the message. The voice message is sent to recipient with an 'RE:' added to original subject of the 
message.

To Use Reply All via the Telephone Recording and Playback Feature 

You can use reply all to a voice message using the Phone option that is available on computer, as well as mobile.

Step 1 Click the Reply all link given in the email notification or click the Reply all button given in the Unity Connection 
Mini Web Inbox. The Reply to Message window opens.

The To and Sub fields along with the message properties gets inherited from the parent voice message. The user does not 
have an option to append or edit these fields. The CC and BCC fields do not get inherited from the actual message.
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Note In order to utilize the Add CC and/or Add BCC options, a user must use the Cisco Unity Connection Web Inbox 
as these options are not available from the Unity Connection Mini Web Inbox.

Step 2 Click Phone to enter an editable number or use the auto-populated number depending on the settings done for each 
user for HTML notification outdial number. The phone number entered  here can also be in  the E.164 format. In 
addition, check if there are any restriction rules are set by the administrator to block some number. For more 
information on the restriction rules refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsag110.html.

Note A user can edit the phone number or extension, if the administrator has given rights to edit the mobile number from 
Cisco PCA. For more information to update the settings refer to Managing Message Notification through the 
Messaging Assistant Web Tool, page 41.

Note If there is no phone number configured by an administrator and even the user does not have rights to edit the mobile 
number from Cisco PCA, then the "Callback number has not been assigned. Please contact administrator" message 
is displayed.

Step 3 Click Start Recording. 

Step 4 Record the voice message and when done, click Stop Recording. The duration of the recording is displayed on the 
window.

Note You can even play your recorded message and if require, can even re-record the message. The previously recorded 
message gets overwritten.

Step 5 Click Send to send the message. The voice message is sent to recipient with an 'RE:' added to original subject of the 
message.

Forward Option
The user can forward a voice message and can attach any further introduction or message to the existing message by following 
any of the actions given below:

• Click the Forward link as displayed in the email notification,

• Forward the message through the Computer button if accessing the Unity Connection Mini Web Inbox through computer, 
or

• Forward the message through the Phone button given in the Unity Connection Mini Web Inbox via computer or mobile

Forward Window on Computer

Forward Window on Mobile
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The user can forward a voice message by recording through the Computer option or using the phone recording and playback 
functionality, depending upon the option selected at the time of playing a message. If a user wants to toggle between the 
Computer or Phone options on computer while forwarding a message, the user needs to go back to the main Unity Connection 
Mini Web Inbox window and re-select the Computer or Phone option. The toggling between the Computer or Phone options is 
not allowed from the Forward Message window. In addition, the toggling is supported when the voice message is not in the 
playing state either from computer or mobile.

Note The IPhone supports recording duration for 3 minutes and 50 seconds.

Auto-Inherit Properties
The forward message auto inherits the secured and urgent properties of the original message. If the original message was urgent, 
secure, or urgent and secure, the forward message will also be of the same type. The user is not allowed to edit or provide the 
private and secured properties from the Unity Connection Mini Web Inbox. Also, a private message cannot be forwarded.

Note The recording on MAC OS is supported via telephone record and playback functionality only. The computer based 
recording is not supported.

To Forward a Voice Message Using the Computer Recording

Unity Connection Mini Web Inbox on computer supports the Computer option to forward a voice message that uses the 
computer microphone and speakers or other default audio device. If you are accessing the Unity Connection Mini Web Inbox 
on mobile, the Computer option will not be available as the mobile based mini player supports only telephone record and 
playback functionality.

Step 1 Click the Forward link given in the email notification or click the Forward button given in the Unity Connection 
Mini Web Inbox. The Forward Message window opens with the To text field.

The Sub field along with the message properties is populated automatically in the background. The user does not have an 
option to append or edit the subject.

Note In order to utilize the Add CC and/or Add BCC options, a user must use Cisco Unity Connection Web Inbox as these 
options are not available from Unity Connection Mini Web Inbox.

Step 2 Enter an email address to which you want to forward the message in the To field.

Note The auto-fill functionality in the To field will display maximum of 3 users for searching and adding a user in the 
To field while forwarding a message.

Step 3 Click Start Recording. 

Step 4 Record the voice message and when done, click Stop Recording. The duration of the recording is displayed on the 
window.
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Note You can even play your recorded message and if require, can even re-record the message. The previously recorded 
message gets overwritten.

Step 5 Click Send to send the message. The voice message is sent to the recipient with an 'Fw:' added to the original subject 
of the message.

To Forward a Voice Message Using the Telephone Recording and Playback Feature

You can forward a voice message using the Phone option that is available on computer, as well as mobile.

Step 1 Click the Forward link given in the email notification or click the Forward button given in the Unity Connection 
Mini Web Inbox. The Forward Message window opens with the To text field.

The Sub field along with the message properties are populated automatically in the background. The user does not have an 
option to append or edit the field.

Note In order to utilize the Add CC and/or Add BCC options, a user must use Cisco Unity Connection Web Inbox as these 
options are not available from the Unity Connection Mini Web Inbox.

Step 2 Enter an email address to which you want to forward the message in the To field.

Note The auto-fill functionality in the To field will display maximum of 3 users for searching and adding a user in the 
To field while forwarding a message.

Step 3 Click Phone to enter an editable number or use the auto-populated number depending on the settings done for each 
user for HTML notification outdial number. The phone number entered  here can also be in  the E.164 format. In 
addition, check if there are any restriction rules are set by the administrator to block some number. For more 
information on the restriction rules refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsag110.html.

Note A user can edit the phone number or extension, if the administrator has given rights to edit the mobile number from 
Cisco PCA. For more information to update the settings refer to Managing Message Notification through the 
Messaging Assistant Web Tool, page 41.

Note If there is no phone number configured by an administrator and even the user does not have rights to edit the mobile 
number from Cisco PCA, then the "Callback number has not been assigned. Please contact administrator" message 
is displayed.

Step 4 Click Start Recording. 

Step 5 Record the voice message and when done, click Stop Recording. The duration of the recording is displayed on the 
window.

Note You can even play your recorded message and if require, can even re-record the message. The previously recorded 
message gets overwritten.

Step 6 Click Send to send the message. The voice message is sent to the recipient with an 'Fw:' added to the original subject 
of the message.
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Mark Unread Option
Unity Connection Mini Web Inbox allows the users to mark an already read voice message as unread by following either of the 
action given below:

• Clicking the Mark Unread link as displayed in the email notification or 

• Clicking the Mark Unread button given in the Unity Connection Mini Web Inbox

Mark Unread Window on Computer

Mark Unread Window on Mobile

To Mark a Voice Message Unread 

Step 1 Click the Mark Unread link given in the email notification or click the Mark Unread button given in the Unity 
Connection Mini Web Inbox. 

The message is marked as unread. The unread message count given below in the Unity Connection Mini Web Inbox gets 
increased by one count.

Delete Option
Unity Connection Mini Web Inbox allows the users to delete a voice message by following any of the action given below:

• Clicking the Delete link as displayed in the email notification or 

• Clicking the Delete button given in the Unity Connection Mini Web Inbox

Delete Window on Computer
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Delete Window on Mobile

To Delete a voice message 

Step 1 Click the Delete link given in the email notification or click the Delete button given in the Unity Connection Mini Web 
Inbox. 

If the administrator has configured the Delete Messages Without Saving to Deleted Items Folder message option in the Class 
of Service template, a confirmation message appears to permanently delete the voice message.

If the above delete messages settings are not configured, the message gets marked as delete with the 'D' icon and moved to 
the Deleted folder. The Undelete Option is visible if the user manually refreshes the window or again opens the notification 
link from the email. The deleted voice message will now gets open from the deleted items folder in the Unity Connection 
Mini Inbox The user is not allowed to perform any other operation other than the play and undelete option on the deleted 
message.

Sign Out Option
Once the user signs out from the Unity Connection Mini Web Inbox, he must click the mini player link in the notification email 
to access the mini player again.

Notable Behavior for Support of Types of Messages in Unity Connection Mini Web 
Inbox
Unity Connection Mini Web Inbox supports voice and urgent messages. However, the HTML notifications and mini player does 
not support the following message types:

• Dispatch Messages

• Fax

• Transcription

• Calendar Notifications
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Limitations
Limitations of the Unity Connection Mini Web Inbox:

• IPhone supports recording till 210 seconds only.

• If the user records a voice message with more than 210 seconds, say 250 seconds, then the user will not be able to send the 
recorded voice message and the warning message “Maximum recording of 210 seconds is supported on IPhone.” is 
displayed.

• While playing a voice message the progress bar in the mini player gets hanged after 3 mins and 59 secs. However, the user 
will still be able to hear the entire message.

• Make sure the required SSL certificates are installed on your IPhone.

• If you have entered wrong authentication credential details when the authentication mode is selected, you need to clear the 
browser cache.

10  Managing Message Notification through the Messaging Assistant Web 
Tool
Cisco Unity Connection can call a phone or pager to notify you about new messages. Unity Connection can also send message 
notifications in the form of HTML, text, and SMS messages (for example, "Urgent message for Technical Support" or "You 
have new voice messages") to email addresses, text pagers, text-compatible mobile phones, and other such devices.

Unity Connection calls a phone or pager or sends a HTML/text message based on the notification schedules and contact options 
that you specify. You can use the Messaging Assistant web tool to set up the following notification devices: a home phone, a 
mobile phone, a pager, an email device (such as a text pager or home email address), and a work phone. You may also be able 
to set up additional devices, such as alternative phones, alternative email devices, an SMS device, or an HTML device. Your 
Unity Connection administrator can tell you whether these options are available to you.

Tip If your text-compatible mobile phone has an email address for receiving text messages, you can set up an email or SMS 
notification device to use this phone as a text pager. SMS (SMPP) notifications are for use with GSM mobile phones 
and other SMS-compatible devices. SMS notifications are generally much faster than email (SMTP/HTML) text pager 
notifications, and some SMS service providers offer the additional benefit of replacing a previous notification with the 
latest one.

Cisco Unity Connection also allows you to deliver SMTP-based HTML notifications for a new voice message to the end users. 
These notifications can be sent as an HTML format embedded in the email via SMTP. The users get the flexibility to receive the 
HTML notifications that can include customized icons, header, and footer along with the link to access Cisco Unity Connection 
Mini Web Inbox. Cisco Unity Connection Mini Web Inbox is a player that allows the user to play the notified messages over a 
computer or mobile devices. 

The HTML notifications on the computer support non plug-in based:

• Web email clients 

• Desktop email clients like Microsoft Outlook and IBM Lotus Notes

The HTML notifications on the mobile support:

• Web email clients

To receive the notifications in the form of the HTML notification templates, you must enable the HTML notification device and 
assign a notification template. The user can only select a notification template if not restricted by the administrator. In case the 
administrator has restricted the user from selecting a template, the required field will be grayed out.  

Cisco Unity Connection Administration, Cisco PCA, and the CUPI APIs can be used to create, update, and delete an HTML 
notification device. The user can manage his or her own notification devices using Cisco PCA and also has the flexibility to 
perform certain operations using the CUPI APIs. For more information, refer to 
http://docwiki.cisco.com/wiki/Cisco_Unity_Connection_Provisioning_Interface_(CUPI)_API_--_For_End_Users_--_HTML_No
tification_Devices.
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Setting Up the Notification Devices
For Cisco Unity Connection to make notification calls, the notification device must be enabled. Disabling a notification device 
does not delete its settings. Unity Connection considers notification successful if the device answers, even when new messages 
remain. (For example, notification is considered successful even when an answering machine picks up and records the message.)

You can change the type of events that Unity Connection notifies you of, the callers or phone numbers that trigger a device, 
your notification schedules, and the contact options for your notification devices only in the Messaging Assistant web tool, not 
by phone.

Setting Up or Changing an HTML Notification Device

To setup or change an HTML Notification Device 

Step 1 In the Messaging Assistant, from the Notification Devices menu, select View Notification Devices.

Step 2 On the Notification Devices page, select the HTML device that you want to change or set up.

Step 3 On the <Device name> Notification Device page, check the Notification Enabled check box to enable the device, or 
uncheck it to disable the service.

Step 4 In the To field, enter a valid email address.

Step 5 In the Select HTML Template drop-down list, select a default or customized template. This field will be inactive if the 
administrator has not given rights to the user to select an HTML template.

Step 6 Click Preview to view format of an HTML-based SMTP notification for the selected template.

Step 7 In the Outdial Number field, enter the phone number that you will use to check the notifications. This field will be 
inactive if the administrator has not given rights to the user to enter mobile number from Cisco PCA. The number 
entered here can be E.164 compliant. For more information on the restriction rules refer to 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsag110.htm. 

Step 8 Check the Urgent Only check box to have Unity Connection send the notification only when the new voice message of 
that type is marked urgent.

Step 9 To specify that this device will receive notifications only for messages from specific Unity Connection users, select Add 
Callers, and then search for names: 

a. In the Find Names dialog box, enter search criteria, then select Find. 

b. In the search results, select the check box next to the user or remote contact that you want to add to your Callers list, 
then select Add Users. 

Step 10 To specify that this device receive notifications only for messages from specific phone numbers, enter a phone number 
in the Number Pattern field. You can use the wildcard characters X and * to match more than one phone number:

– The X character matches any single digit in the range 0 through 9. For example, the pattern 9XXX matches the range 
of phone numbers from 9000 through 9999.

– The asterisk (*) character matches any sequence of digits. For example, the pattern 5556304* matches the phone 
numbers 5556304, 55563040, 55563041, 5556304100, and so forth.

Tip If you specify both Callers and Phone Numbers for a device, Unity Connection will send the device a notification for 
any message, irrespective of the types you specified in Step 9 that matches any of the callers or number patterns you 
specify.

Step 11 To set up your notification schedule, do either of the following:

– Use the Quick Add options to specify a schedule, or

– Check or uncheck the check boxes in the schedule to specify the active and inactive hours for the notification device. 

Unity Connection makes notification calls during the active hours, if you have new messages. When a new message 
arrives during inactive hours, Unity Connection sends a message notification at the start of the next active hour in your 
schedule. 
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Tip There are several ways to set up your notification schedule quickly. Select Clear Schedule to uncheck all check boxes at 
once. Alternatively, select Invert Schedule to check all the boxes that you currently do not have checked and uncheck 
the ones that you do have checked. You can use the Copy Day's Schedule function-below the schedule-to copy a 
schedule for one day to other days.

11  Configuring Cisco Unity Connection 10.x for HTML-based Message 
Notification
Cisco Unity Connection can be configured to send message notifications in the form of HTML template to an email address. All 
HTML notifications in Unity Connection require an HTML-based notification template. The HTML-based templates can be 
selected and applied by the administrator to allow HTML notification for a device. The template selected can either be a default 
or a custom template that the administrator has created.

For more information on how to create a template, refer to Working with the Notification Template, page 3.

To get the HTML notifications exactly as per the template defined by the administrator, the user’s email client must support the 
display of images and icons. For more information on whether your email client support the display of images and icons, refer 
to documentation of your email service provider. 

HTML notifications are supported with the following email clients:

• Microsoft Outlook 2007

• Microsoft Outlook 2010

• IBM Lotus Notes 

• Gmail (Web based access only)

The user must ensure to select the authentication or non-authentication mode as desired. In addition, make sure the signed SSL 
certificates are installed in order to access the notifications via email and the voice message via Unity Connection Mini Web 
Inbox. 

For more information on how to configure SSL on Cisco Unity Connection, refer to the “Securing Cisco Unity Connection 
Administration, Cisco PCA, and IMAP Email Client Access to Cisco Unity Connection 10.x” chapter of the System 
Administration Guide for Cisco Unity Connection Release 10.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsagx.html. 

See the following sections:

• Configuring the Authentication Mode, page 43

• Configuring the Non-Authentication Mode, page 44

• Configuring Microsoft Outlook to Display Images in an HTML Message Notification, page 44

• Configuring Microsoft Outlook for Automatic Image Download, page 46

• Configuring Cisco Unity Connection to Send Voice Message as an Attachment, page 46

• Configuring the Size of Voice Messages Sent as an Attachment with HTML Notification, page 46

Configuring the Authentication Mode
If the administrator has created a template that include images, icons, and/or status items, then the authentication mode ensures 
that the user authenticates with his/her Unity Connection credentials before the images are displayed as an HTML email on an 
email client.

By default, the system is configured for the authentication mode. The administrator can configure the authentication mode using 
the Cisco Unity Connection Administration. 
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To Configure the Authentication Mode

Step 1 In Cisco Unity Connection Administration, select System Settings > General Configuration.

Step 2 On the Edit General Configuration page, select the Authenticate Graphics for HTML Notification option to turn on 
the authentication mode.

Step 3 Click Save.

Note • The Unity Connection credentials are required only once for each session of Microsoft Outlook.

Note • If the user clicks on the Cancel button and does not enter Unity Connection credentials when prompted at the first 
instance then no image will be displayed in the email notification. You must restart the Microsoft Outlook to enter 
the Unity Connection credentials and view the images.

Note • If the user enters wrong password thrice then Unity Connection will not prompt again and the user must restart 
the Outlook.

Configuring the Non-Authentication Mode
The non-authentication mode does not prompt user for credentials and the embedded images or icons are displayed without 
authentication in the email notification.

To Configure the Non-Authentication Mode

Step 1 In Cisco Unity Connection Administration, select System Settings > General Configuration.

Step 2 On the Edit General Configuration page, deselect the Authenticate Graphics for HTML Notification option to turn off 
the authentication mode.

Step 3 Click Save.

Configuring Microsoft Outlook to Display Images in an HTML Message Notification
In the authentication mode, to view all the custom graphics or administrative replaceable images as per the HTML-based 
template, you must make sure that your Microsoft Outlook client has all the required hotfixes and registry entries. 

If the non-authentication mode is configured then your Microsoft Outlook client does not require any hotfixes or registry 
entries. 

Caution The user workstation must have the SSL certificates installed irrespective of the mode selected (authentication or 
non-authentication). 
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For more information on how to configure SSL on Cisco Unity Connection, refer to the “Securing Cisco Unity Connection 
Administration, Cisco PCA, and IMAP Email Client Access to Cisco Unity Connection 10.x” chapter of the System 
Administration Guide for Cisco Unity Connection Release 10.x, available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/administration/guide/10xcucsagx.html. 

If you are using Internet Explorer version 8, refer to the settings given in the Configuring Internet Explorer 8 for Cisco Unity 
Connection Mini Web Inbox, page 47 section.

Note If due to certain security implications you are not allowed to install the required hotfixes or update registry entries, then 
you can create the templates without images, MWI status, and message status.

To Update the Registry Entries for Microsoft Outlook

Step 1 Go to Start > Run. Type regedit and press Enter.

Step 2 Browse to the following path:

For Microsoft Office 2007

HKEY_CURRENT_USER\Software\Microsoft\Office\12.0\Common

For Microsoft Office 2010

HKEY_CURRENT_USER\Software\Microsoft\Office\14.0\Common

Step 3 Add “AllowImageProxyAuth = 1” as new DWORD value.

Table 11 Microsoft Outlook Settings Required for Authentication Mode

Platform/Email 
Client Microsoft Outlook 2007

Microsoft Outlook 2010 (32 bit 
and 64 bit)

Windows XP 
SP3, Windows 7 
(32 and 64 bit), 
and Windows 
Vista (32 and 64 
bit)

Microsoft Outlook 2007

• Registry entry for AllowImageProxyAuth, 
where value=1.

• Either Install 2007 Office suite SP2. To 
install 2007 Office suite SP2, refer to 
http://support.microsoft.com/kb/953195. 
Then, install Microsoft Outlook 2007 
hotfix package. To install hotfix, refer to 
http://support.microsoft.com/kb/2596993. 
OR

• Install 2007 Office suite SP3. To install 
2007 Office suite SP3, refer to 
http://support.microsoft.com/kb/2526086.

Microsoft Outlook 2007 with SP2

• Install Microsoft Outlook 2007 hotfix 
package. To install hotfix, refer to 
http://support.microsoft.com/kb/2596993.

• Registry entry for AllowImageProxyAuth, 
where value=1.

Microsoft Outlook 2007 with SP3

• Registry entry for AllowImageProxyAuth, 
where value=1.

• Install Microsoft Outlook 
2010 hotfix package. For 
more information, refer to 
http://support.microsoft.c
om/kb/2459116.

• Registry entry for 
AllowImageProxyAuth, 
where value=1.
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Configuring Microsoft Outlook for Automatic Image Download
Even after updating your Microsoft Outlook with required hotfixes and registry entries, you need to right click on the image, 
if any given in the template and select Show images. You can also right click on the prompt appearing at the above of message 
window to show the images. 

To get your images automatically downloaded without performing these steps with every session, you must select the required 
options given under the Tools > Trust Center > Automatic Download section in your Microsoft Outlook email client.

Configuring Cisco Unity Connection to Send Voice Message as an Attachment
Starting with Cisco Unity Connection 10.0(1) release, the administrator can now configure Unity Connection to send the voice 
message as an attachment in the HTML notification to the user. Along with the link to access Unity Connection Mini Web Inbox 
through the HTML notification email, the user can now access the voice message attachment in the .wav format that can be 
played on PC or mobile using any player. Prior to Unity Connection 10.0(1) version, the end user received only a link in the 
HTML notifications to access Unity Connection Mini Web Inbox and listen to voice messages through Mini Web Inbox only. 

Note In case of forwarded messages, the attachement is sent only for the latest voice message.

If a user tries to access the voice message attachment using mobile, the following mobile clients are supported:

• Supported versions of iPhone 4 and above

• Supported versions of Android 

Note The secure and private voice messages cannot be sent as an attachment.

By default, the system is configured for not to send the voice message as an attachment. The administrator can configure to send 
voice message as an attachment using the Cisco Unity Connection Administration. 

To Configure Unity Connection to Send Voice Message as an Attachment

Step 1 In Cisco Unity Connection Administration, select Advanced > Messaging.

Step 2 On the Messaging Configuration page, select the Allow voice mail as attachments to HTML notifications option to 
send the voice message as an attachment.

Step 3 Click Save.

Configuring the Size of Voice Messages Sent as an Attachment with HTML Notification
The administrator can configure the size of voice messages sent as an attachment with HTML notifications. The user can access 
the voice message attachment in the .wav format that can be played on PC or mobile using any player. 

By default, the system is configured to send the voice message as an attachment upto 2048KB. The administrator can configure 
the size of the voice message using the Cisco Unity Connection Administration. 

To Configure the Size of Voice Message Sent as an Attachment

Step 1 In Cisco Unity Connection Administration, select Advanced > Messaging.

Step 2 On the Messaging Configuration page, enter the size of voice message in the Max size of voice mail as attachment to 
HTML notifications (KB) text box.

Step 3 Click Save. Make sure to restart the Connection Notifier service for changes to take effect.
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12  Configuring Cisco Unity Connection 10.x for Cisco Unity Connection 
Mini Web Inbox
See the following sections:

• Configuring IBM Lotus Notes for Cisco Unity Connection Mini Web Inbox, page 47

• Configuring Internet Explorer 8 for Cisco Unity Connection Mini Web Inbox, page 47

• Configuring Windows Vista and Windows 7 (32 bit and 64 bit) for Cisco Unity Connection Mini Web Inbox, page 47

Configuring IBM Lotus Notes for Cisco Unity Connection Mini Web Inbox
Cisco Unity Connection Mini Web Inbox does not support the default IBM Lotus Notes supported browser. When a user 
receives a message notification on his IBM Lotus Notes email client and clicks a link in the notification to open Unity Connection 
Mini Web Inbox, the Unity Connection Mini Web Inbox must open in the default operating system browser.

To Configure the Web Browser as Operating System Default Browser in Lotus Notes Email Client

Step 1 In your Lotus Notes client, select File > Preferences > Web Browser.

Step 2 Select the Use the browser I have set as the default for this operating system option.

Step 3 Click Apply and then Ok.

Configuring Internet Explorer 8 for Cisco Unity Connection Mini Web Inbox

To Configure Internet Explorer 8 for Cisco Unity Connection Mini Web Inbox

Step 1 In your browser window, go to Tools > Intranet Options and select the Security tab.

Step 2 Select the Local intranet option and click Sites.

Step 3 Uncheck all the check boxes and click Ok.

Step 4 Select the Trusted sites option and click Sites.

Step 5 Add the website that you are using for Unity Connection, for example, https://ucbu-cisco-vmxyz.cisco.com.

Step 6 Click Close and then Ok.

Configuring Windows Vista and Windows 7 (32 bit and 64 bit) for Cisco Unity 
Connection Mini Web Inbox

To Configure Windows Vista and Windows 7 (32 bit and 64 bit) for Cisco Unity Connection Mini Web 
Inbox

Step 1 Select Start > Control Panel > Flash Player.

Step 2 Select the Camera and Mic tab in the Flash Player Settings Manager window.

Step 3 Click Camera and Microphone Settings by Site.

Step 4 Select the Ask me when a site wants to use the camera or microphone option in the Camera and Microphone Settings 
by Site window.

Step 5 Click Add.
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Step 6 Add the website that you are using for Unity Connection, for example, ucbu-cisco-vmxyz.cisco.com.

Step 7 Click Allow and then Close.

13  Troubleshooting the HTML Notifications in Cisco Unity Connection
Cisco Unity Connection allows you to deliver the SMTP-based HTML notifications for a new voice message to the end users. 
These notifications can be sent as an HTML format embedded in the email via SMTP. The users get the flexibility to receive the 
HTML notifications that can include customized icons, header, and footer along with the link to access Cisco Unity Connection 
Mini Web Inbox. Unity Connection Mini Web Inbox is a player that allows user to play the voice messages over computer or 
mobile devices.

Ensure that you have taken care of all the requirements and checklist while creating the HTML templates. For more information 
on the checklist while creating and rendering a template, refer to the “Checklist for Creating and Rendering a Template - Must 
haves” section in the “Adding, Modifying, or Deleting a Notification Template in Cisco Unity Connection 10.x” chapter of the 
User Moves, Adds, and Changes Guide for Cisco Unity Connection Release 10.x available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/user_mac/guide/10xcucmacx.html.

For more information on ‘Must Haves’ for Cisco Unity Connection Mini Web Inbox, refer to the Quick Start Guide for the 
Cisco Unity Connection Mini Web Inbox available at 
http://www.cisco.com/en/US/docs/voice_ip_comm/connection/10x/quick_start/guide/10xcucqsgminiinbox.html.

Note It is recommended, that the Unity Connection Mini Web Inbox must always be opened from the notification email as 
it requires certain URL parameters.

Task List for Troubleshooting Problems with HTML Notifications and Unity Connection Mini Web Inbox
When the HTML notifications or Unity Connection Mini Web Inbox fail to operate properly, use the following suggestions to 
resolve the problem

• If the HTML notifications are not received by the users, review "HTML Notifications Are Not Received By the Users, 
page 48" section.

• If the images are not displayed in the email notification on Microsoft Outlook, review the "Images Are Not Displayed on 
Microsoft Outlook, page 49" section.

• If the images are not displayed in the email notification on Internet Explorer 8, review the "Images Are Not Displayed on 
Internet Explorer 8, page 49" section.

• If the images are not displayed in the email notification on IBM Lotus Notes, review the "Images Are Not Displayed on 
IBM Lotus Notes, page 50" section.

• lf the hyperlinks are not visible in the email notification, review the "Hyperlinks Are Not Visible in the Email Notification, 
page 50" section.

• If you are not able to launch Unity Connection Mini Web Inbox, review the "Unable to Launch Unity Connection Mini Web 
Inbox, page 50.

• Review the "Unable to View the Updated Cisco Unity Connection Mini Web Inbox Interface in Internet Explorer, page 50" 
section if the user is not able to view the updated Unity Connection Mini Web Inbox window on Internet Explorer.

• If you are not able to play and record messages on computer using Unity Connection Mini Web Inbox, review the "Unable 
to Play and Record Voice Messages on Computer Using Cisco Unity Connection Mini Web Inbox, page 50" section.

HTML Notifications Are Not Received By the Users
If the users are not receiving the HTML notifications, ensure the following steps:

• Confirm that the smart host hostname is configured from Cisco Unity Connection Administration. For more information, 
refer to Enabling an HTML-compatible Device to Receive HTML-Based Message Notifications, page 23.
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• Ping the smart host from Unity Connection server. If the ping fails, there is a possibility that network Unity Connection is 
not functional and you must restore the network Unity Connection.

• Confirm that the 'Unity Connection Notifier' service is up and running.

• Confirm that the HTML notification device is enabled. For more information on how to setup the HTML notification 
device, refer to Enabling an HTML-compatible Device to Receive HTML-Based Message Notifications, page 23.

• Confirm that a valid email address is specified while configuring HTML notifications for a user. For more information on 
how to setup the HTML notification device, refer to Enabling an HTML-compatible Device to Receive HTML-Based 
Message Notifications, page 23.

Images Are Not Displayed on Microsoft Outlook
If the user is using Microsoft Outlook client for checking the email notifications and is unable to view the images in the 
notification, do the following steps:

• If the images are not displayed, right click the image and select the Show Images options.

• Make sure the minimum requirements for images to be displayed on Microsoft Outlook are met. To check the settings for 
Microsoft Outlook, refer to Configuring Cisco Unity Connection 10.x for HTML-based Message Notification, page 43.

• If the authentication mode is selected, then make sure you are giving the correct credentials. 

• If the user enters wrong password thrice continuously then Unity Connection will not prompt the user again and the user 
must restart the Microsoft Outlook. To enter the credentials and display the images in the notification you must restart the 
Microsoft Outlook.

• When prompted for credentials at the first instance, if the user clicks on the Cancel button and does not enter Unity 
Connection credentials then no image will be displayed in the email notification. You must restart the Microsoft Outlook 
to enter the Unity Connection credential and view the images.

• If the images are not getting displayed in the email notification even after installing the required hotfix and Microsoft 
Outlook has been restarted, then follow the below mentioned steps:

a. Check the version of MSO.DLL from the path C:\Program Files\Common Files\Microsoft Shared\MSORUN on the 
Windows machine. Ensure that the version of MSO must include the fix. For more information on version, refer to the 
details of the Microsoft Outlook 2007 and Microsoft Outlook 2010 hotfix.

b. After restarting Microsoft Outlook, you must ensure that it is no longer running by ending any running process of 
Outlook.exe from the Task Manager window. The changes to MSO.DLL will take affect only after proper shutdown 
and restart of the Microsoft Outlook.

• Make sure that the registry entry for AllowImageProxyAuth was made for DWORD only.

• If the user is not able to see any images even after all the recommended settings, check the network connectivity of the Unity 
Connection Server with Internet Explorer by copying the link of the images and manually opening it over the browser.

– You can check the connectivity via wireshark captures and filtering over SSL packet flow over 443 or 8443 port for the 
communication.

Images Are Not Displayed on Internet Explorer 8
If the user is using Microsoft Internet Explorer 8 for checking the email notification and unable to view the images, do the 
following steps:

• Confirm the option to display the images is enabled. For more information refer to Configuring Cisco Unity Connection 
10.x for HTML-based Message Notification, page 43.

• If the authentication mode is selected, then make sure you are giving the correct credentials. For more information on how 
to select the authentication mode, refer to Configuring Cisco Unity Connection 10.x for HTML-based Message 
Notification, page 43.
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Images Are Not Displayed on IBM Lotus Notes
If the user is using IBM Lotus Notes for checking the email notification and unable to view the images, do the following steps:

• If the images are not displayed, right click the image and select show images options.

• If the authentication mode is selected, then make sure you are giving the correct credentials. For more information on how 
to select the authentication mode, refer to Configuring Cisco Unity Connection 10.x for HTML-based Message 
Notification, page 43.

Hyperlinks Are Not Visible in the Email Notification
If the hyperlinks given in the notification template are not visible in the notification, then you need to make sure that the HTML 
notification template in Cisco Unity Connection Administration has the valid HTML tags and all items (static, action, and status 
items) are given correctly.

For more information on how to define the tags and the items, refer to Working with the Notification Template, page 3.

Unable to Launch Unity Connection Mini Web Inbox
If the user is unable to launch the Unity Connection Mini Web Inbox, ensure the following settings:

• Confirm that under COS assigned to the user, Web Inbox is enabled.

• Confirm that the message for which you are opening the Unity Connection Mini Web Inbox is not deleted.

• Confirm that the user is logged in with the valid user name.

Unable to View the Updated Cisco Unity Connection Mini Web Inbox Interface in 
Internet Explorer

To View the Updated Interface of Unity Connection Mini Web Inbox

Step 1 Open Internet Explorer and then go to Tools.

Step 2 In the Internet Options window under the Browsing History section, click Settings.

Step 3 In the Temporary Internet Files and History Settings window, select the Every time I visit the webpage option to check 
the newer version of stored pages option.

Step 4 Click Ok.

Unable to Play and Record Voice Messages on Computer Using Cisco Unity 
Connection Mini Web Inbox 
If the user is unable to play and record voice messages on computer using Unity Connection Mini Web Inbox, confirm the 
following:

• Confirm that the outdial number is configured. For more information on how to setup the outdial number and other fields 
for the HTML notification device, refer to Enabling an HTML-compatible Device to Receive HTML-Based Message 
Notifications, page 23.

• Confirm that the callback number is configured.

• Confirm that the end user answers the phone.
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